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1Getting Started

This chapter includes:
• Machine Overview
• Product Configurations
• Control Panel
• Powering On the Machine
• Software
• Information Pages
• More Information
• Further Assistance
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Machine Overview
Machine Overview

Before you use your machine, take some time to familiarize yourself with the various features and 
options.

Front View

1 Output Tray 6 Manual Feeder Slot

2 Control Panel 7 Paper Width Guides on Manual Feeder Slot

3 Front Cover 8 Output Support

4 Paper Level Indicator 9 Toner Cartridge

5 Paper Tray 1 10 Drum Cartridge
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Machine Overview
Rear View

1 Network Port

2 USB Port

3 Power Receptacle

4 Rear Cover
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Product Configurations
Product Configurations

Component Phaser 
3052NI

Phaser 
3260DI

Phaser 
3260DNI

Phaser 
3260DN

Paper Tray 1 (250 sheets) Standard Standard Standard Standard

Output Tray (150 sheets) Standard Standard Standard Standard

Manual Feeder Slot (1 sheet) Standard Standard Standard Standard

AirPrint Standard Standard Standard Standard

Google Cloud Print Standard Standard Standard Standard

USB Device Standard Standard Standard Standard

USB Host Not Applicable Not Applicable Not Applicable Not Applicable

Network Printing Standard Not Applicable Standard Standard

Wi-Fi Standard Standard Standard Not Applicable

Wi-Fi DirectTM Standard Standard Standard Not Applicable
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Control Panel
Control Panel

The control panel consists of buttons you press to control the functions available on the printer. 

.

Number Button Description

1 Toner LED: Shows the status of the toner. Displays a blinking light 
when the toner level is low. Displays a solid light when the toner is out.

2 eco: Enters Earth Smart mode to reduce toner consumption and paper 
usage.

3 WPS: Configures the wireless network connection without a computer. 
Press this button each time you load a sheet of paper in the tray if you 
selected Manual Feeder as the Source in your printer driver.
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Control Panel
4 Stop: Stops an operation at any time.
Cancels the current job.
Prints a demo page: Press and hold this button for about 2 seconds 
until the Status LED blinks slowly.
Supplies Information and Usage Counter: Press and hold this button 
for about 6 seconds.
Configuration reports and Network Configuration reports: Press and 
hold this button for about 4 seconds until the status LED blinks fast.

5 Power: Turns the power off or wakes the machine from sleep mode.

6 Status LED: Shows the status of your machine.

Number Button Description
Xerox® Phaser® 3052/3260
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Powering On the Machine
Powering On the Machine

The power button is located on the control panel. The power cable socket is located at the rear of the 
printer.
1. Connect the AC Power Cord to the machine and a power outlet. The power cord must be plugged 

into a grounded power socket.
2. Press the Power button on the control panel. 

Power Save

This machine contains advanced energy conservation technology that reduces power consumption 
when it is not in active use. When the printer does not receive data for an extended period of time, the 
Power Save mode becomes active and power consumption is automatically lowered.

Powering Off the Machine

Press and hold the Power button.
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Software
Software

After you have set up your machine and connected it to your computer, you must install the printer 
software. The software required for Windows or Macintosh is supplied on the CD delivered with your 
machine. Additional software can be downloaded from www.xerox.com. The following software is 
available:

CD Operating 
System Contents

Printer 
Software

Windows • Printer Driver: Use the printer driver to take full advantage of your 
printer’s features. PCL6, Postscript and XPS drivers are provided.

• Xerox Easy Print Manager (EPM): Conveniently combines access to 
device settings, printing environments, settings/actions, and launching 
applications such as CentreWare Internet Services in one location. 

Note: Log in is required to change Printer Settings.

• Wireless Setting Program: When installing the printer, you can use the 
Wireless Setting program that was automatically installed with the 
printer driver to configure the wireless settings.

• SetIP program: A utility program allowing you to select a network 
interface and manually configure the addresses for use with the TCP/IP 
protocol.

Printer 
Software 

Linux • Printer Driver: Use this driver to take full advantage of your printer’s 
features.

Note: Linux software is available at www.xerox.com only.

Printer 
Software

Macintosh • Printer Driver: Use this driver to take full advantage of your printer’s 
features.

• SetIP Program: A utility program allowing you to select a network 
interface and manually configure the addresses for use with the TCP/IP 
protocol.

• Smart Panel: This utility enables remote management, displaying toner 
levels, printer status, and problem alerts.
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Information Pages
Information Pages

This option allows the user to print the following reports:

Configuration Report

The Configuration Report lists printer information such as default settings, network settings including 
IP address, and font settings. Use the information on the Configuration Report page to help you 
configure network settings for your printer, and to view page counts and system settings.

Printing a Configuration Report:

At the printer control panel, press the Cancel button for more than 4 seconds.

IPv4 and IPv6 address information is located in the Network Setup section of the Configuration Report 
under TCP/IP.

Report Description

Configuration This report provides information about your machine setup, including 
the serial number, IP Address, installed options and the software 
version. 

Demo Page The demo page is printed to check the quality of the print.

Supplies Info Prints the supplies information page.

Network Configuration This list shows information about your machine’s network connection 
and configuration.

Usage Counter This list shows the number of impressions made on the machine. The list 
includes:
• Total Impressions
• Black Impressions
• Maint. Impressions
• Sheets
• 2 Sided Sheets
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Information Pages
Xerox® CentreWare® Internet Services

Xerox® CentreWare® Internet Services is the administration and configuration software installed on the 
embedded Web server in the printer. It allows you to configure and administer the printer from a Web 
browser.

Xerox® CentreWare® Internet Services requires:
• A TCP/IP connection between the printer and the network in Windows, Macintosh, or Linux 

environments.
• TCP/IP and HTTP enabled in the printer.
• A network-connected computer with a Web browser that supports JavaScript.

Accessing Xerox® CentreWare® Internet Services

At your computer, open a Web browser, in the address field, type the IP address of the printer, then 
press Enter or Return.
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More Information
More Information

You can obtain more information about your printer from these sources:

Resource Location

Other printer documentation www.xerox.com/office/3052docs
www.xerox.com/office/3260docs

Technical support information for 
your printer; including online 
technical support and driver 
downloads.

www.xerox.com/office/3052support 
www.xerox.com/office/3260support 

Demo Page The demo page is printed to check the quality of the print.

Information Pages Print from the control panel, or from Xerox® CentreWare® Internet 
Services, click Status > Print Information.

Xerox® CentreWare® Internet 
Services documentation

In Xerox® CentreWare® Internet Services, click Help.

Order supplies for your printer www.xerox.com/office/3052supplies 
www.xerox.com/office/3260supplies 

A resource for tools and 
information, including interactive 
tutorials, printing templates, 
helpful tips, and customized 
features to meet your individual 
needs.

www.xerox.com/office/businessresourcecenter 

Local sales and support center www.xerox.com/office/worldcontacts

Printer registration www.xerox.com/office/register

Xerox® Direct online store www.direct.xerox.com/ 

Management Information Base 
(MIB)

A MIB is a database of objects that can be accessed by a network 
management system.
Xerox public MIBs are located at: 
http://origin-download.support.xerox.com/pub/drivers/MIBs/
Customers can download the MIBs and use their SNMP tool to obtain 
the required information.
Note: All information presented on the Local UI display is also presented 
in the MIB and CentreWare Internet Services. This includes phone 
numbers and passwords as they are being entered. If this presents a 
security concern, Xerox recommends enabling the SNMPv3 and the IP 
Filtering security feature in order to control remote access to the device.
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Further Assistance
Further Assistance

For any additional help, visit our customer Web site at www.xerox.com, or contact the Xerox Support 
Center quoting the machine serial number.

Xerox Support Center

If a fault cannot be resolved by following the display instructions, check the Troubleshooting chapter of 
this guide. If the difficulty persists, contact the Xerox Support Center. The Xerox Support Center will 
want to know the nature of the problem, the machine serial number, the fault code (if any), plus the 
name and location of your company.

The Machine Serial Number can be found on the Configuration Report under Device Profile. It can also 
be found on the data plate on the back of the machine.

Documentation

Most answers to your questions will be provided by this User Guide. Alternatively, you can access 
www.xerox.com/support for additional support and for the following documents: 
• Install Guide - contains information about installing the machine.
• Quick Use Guide - provides basic information on how to use the machine.
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2Installation and Setup

This chapter identifies the key settings that you can customize to meet your requirements. Changing 
these settings is easy and will save you time when using the machine.

Note: Some options may be unavailable depending on your machine configuration. 

This chapter includes:
• Wireless Connectivity
• CentreWare Internet Services
• Network Installation: TCP/IP
• Network Installation: Unix
• Network Installation: Linux
• Printer Drivers
• Windows Drivers
• Macintosh Drivers
• Linux Drivers
• Unix Drivers
• Sharing Your Machine Locally
• Windows Printing
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Wireless Connectivity
Wireless Connectivity

This chapter identifies the key settings that you can customize to meet your requirements. Changing 
these settings is easy and will save you time when using the machine.

Note: Some options may be unavailable depending on your machine configuration. 

The Phaser 3052NI, 3260DI, and 3260DNI are compatible with 802.11 (Wi-Fi®) wireless networks. 
The location where the machine is installed must be covered by an 802.11 wireless network. This is 
typically provided by a nearby wireless access point or router, which is physically connected to the 
wired Ethernet that serves the building.

The machine supports connectivity via a wireless only connection if required. The machine will 
automatically configure wireless networking when powered on. 

Note: The machine will not connect to the wireless network while the network cable is attached. 

There are several ways to configure Wireless Connectivity:
• Using CentreWare Internet Services. For instructions, refer to Configure Wireless 

Connectivity Using CentreWare Internet Services (Phaser 3052NI, 3260DI, and 3260DNI). 
• With the Wireless Setting Program. For instructions, refer to Wireless Setting Program. 

Note: Performing the driver installation at this time may aid wireless setup. Refer to Printer 
Drivers.

To set the Ethernet Speed using CentreWare Internet Services, refer to Setting the Ethernet Speed 
Using CentreWare Internet Services.

Print a Configuration Report

The Configuration Report details the machine software versions and network settings configured for 
the machine.

Print a Configuration Report at the Machine

At the printer control panel, press the Cancel button for more than 4 seconds and then release it.
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CentreWare® Internet Services
CentreWare® Internet Services

CentreWare Internet Services (Internet Services) is the embedded HTTP server application that resides 
in the machine. CentreWare Internet Services allows an administrator to change network and system 
settings on the machine from the convenience of their workstation.

Many features available on your machine will need to be set via the machine and CentreWare Internet 
Services.

Administrator User Name and Password

Many of the features available within CentreWare Internet Services will require an Administrator user 
name and password. The default user name is admin and the default password is 1111.

CentreWare Internet Services Administrator Access

To access CentreWare Internet Services Properties and change settings you will need to log in as 
Admininstrator.

1. At your workstation, open the Web browser and enter the IP Address of the machine in the 
Address Bar.

2. Press Enter. The Home page appears.
There are two ways to access CentreWare Internet Services with the administrator login:
• Select Login at the top of the screen or
• Select the Properties icon. You are then prompted for the ID and Password.

3. Enter the admin for the ID and 1111 for the Password.
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CentreWare® Internet Services
Change the Administrator Password

It is recommended that you change the default administrator password to a more secure password, so 
this Xerox machine is not compromised.

To change the Administrator password:

1. At your workstation, open the Web browser and enter the IP Address of the machine in the 
Address Bar.

2. Press Enter.
3. Select the Properties icon.
4. If prompted, enter admin for the ID and 1111 for the Password, and select Login. 
5. Click Properties.
6. In the Security link on the left hand side, select System Security. 
7. Select the System Administrator link.
8. In the Access Control area:

a. Ensure the Web UI Access Control Enable check box is selected. 
b. In the Login ID field, enter a new login name. 
c. Select the Change password box to change the password. In the Password field, enter a new 

numeric password.
d. Enter the password again in the Confirm Password field.

CAUTION: Do not forget the password or you could be completely locked out of the system, 
requiring a service call.

9. Select Apply to save the changes.
10. Select OK when the acknowledgement message displays.
11. Select the Advanced button. The Advanced Access Control screen appears. 
12. Select Protect Login IPv4 Address to enable this feature if required, and enter an IPv4 Address in 

the box.
13. Select the required option for the Login Failure Policy, for users who fail to login several times. The 

options are: Off, 3 times or 5 times.
14. Select the required option for Auto Logout. The options are 5, 10, 15, or 30 minutes.
15. Select Security Settings Reset if required.
16. Select Save to save your changes.
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CentreWare® Internet Services
Configure Wireless Connectivity Using CentreWare Internet Services 
(Phaser 3052NI, 3260DI, and 3260DNI) 

Note: The machine will not connect to the wireless network while the network cable is attached. 

1. At your workstation, open the Web browser and enter the IP Address of the machine in the 
Address Bar.

2. Press Enter.
3. Select Properties.
4. If prompted, enter the admin for the ID and 1111 for the Password, and select Login. 
5. Select Properties.
6. In the Network Settings link, select the Wi-Fi link. Then select the Wi-Fi link below that.
7. The Connection Status shows the Link Status of the wireless connection.
8. The Wireless Settings area provides options to configure wireless connectivity. The options are 

Easy Wireless Settings and Advanced Settings, and are explained below. 

Use the Easy Wireless Settings Wizard

1. Select the Easy Wi-Fi Settings Wizard button to have the machine find the WPS Settings 
automatically. The SSID screen appears with a list of available wireless networks.

2. Select the required Network Name SSID and click Next.
3. If encryption is required:

a. Enter the WPA Shared Key.
b. Enter the Confirm Network Key and click Next.

4. The Wireless Setup Confirmation screen displays. Click Apply. 

Configure Advanced Wireless Settings

1. Select the Advanced Settings Custom button. The Advanced Wireless Setup screen appears.
2. To enable Wireless Radio, select On from the Wireless Radio menu.
3. Select the required option for SSID:

• Select Search List and select the required network from the drop-down menu. Click the 
Refresh button to update the list of networks available.

• Select Insert New SSID to enter a new wireless network name. 
4. In the Security Setup area:

a. Select the required method of Authentication. 
b. Select the required method of Encryption.

5. Depending on your selections you may be required to enter some or all of the following 
information for the Network Key Setup.
a. Select the required option for Using Key.
b. The Hexadecimal option may be enabled. Click the Hexadecimal check box to deselect if 

required.
c. Enter the required Network Key and Confirm Network Key.

6. Depending on your selections you may be required to enter 802.1x Security Setup information.
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CentreWare® Internet Services
7. Select Apply to save the changes. 

Configuring Wi-Fi DirectTM using CentreWare Internet Services

Wi-Fi DirectTM allows you to enable your wireless devices, such as notebooks, mobile phones and PCs to 
establish wireless connectivity without the need for a wireless router, access point, or Wi-Fi hot spots.
1. At your workstation, open the Web browser and enter the IP Address of the machine in the 

Address Bar.
2. Press Enter.
3. Select Properties.
4. If prompted, enter the admin for the ID and 1111 for the Password, and select Login. Click 

Properties.

5. In the Network Settings link, select the Wi-Fi link. Then select the Wi-Fi DirectTM link below that.

6. Select On for Wi-Fi DirectTM.
7. Enter the following:

• Device Name
• IP Address
• Activate or Deactivate the Group Owner
• Network Key

8. Select Apply and then OK.

Setting the Ethernet Speed Using CentreWare Internet Services

1. At your workstation, open the Web browser and enter the IP Address of the machine in the 
Address Bar.

2. Press Enter.
3. Select Properties.
4. If prompted, enter the Administrator User Name (admin) and Password (1111), and select Login. 

Click Properties.
5. In the Network Settings link select the General link. 
6. Select one of the following speeds from the Ethernet Speed drop-down menu:

• Automatic
• 10 Mbps (Half Duplex)
• 10 Mbps (Full Duplex)
• 100 Mbps (Half Duplex)
• 100 Mbps (Full Duplex)

7. Select Apply to save the changes.
The change to Ethernet Speed rate will take effect after System Reboot screen appears. 

8. Select OK.
9. When the Acknowledgement screen displays, select OK.
10. Reboot the machine.
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CentreWare® Internet Services
Adjusting the Altitude

Print quality is affected by atmospheric pressure, which is determined by the height of the machine 
above sea level. The following information will guide you on how to set your machine for the best print 
quality. 

Wi-Fi settings must be configured before you can set the altitude. Refer to Easy Wireless Setup.

Before you set the altitude value, determine the altitude where you are.

1. Enter the IP Address of the printer in the browser.
2. Select Login and enter the ID (admin) and Password (1111).
3. Select Properties > System > Setup.
4. Select an Altitude Adjustment value, based on your altitude in the table above.
5. Select Apply.

Altitude Value

0 - 1000 M
0 - 3,280 ft.

Normal

1000 - 2000 M
3,280 - 6,561 ft.

High 1

2000 - 3000 M
6,561 - 9,842 ft.

High 2

3000 - 4000 M
9,842 - 13,123 ft.

High 3

4000 - 5000 M
13,123 - 16,404 ft.

High 4
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Network Installation: TCP/IP
Network Installation: TCP/IP

These instructions show you how to configure the following via CentreWare Internet Services:
• TCP/IP v4 and v6
• Domain Name
• DNS
• Zero Configuration Networking

The machine supports TCP/IP versions 4 and 6. IPv6 can be used instead of or in addition to IPv4.

IPv4 and IPv6 settings can be configured via a Web browser using CentreWare Internet Services. 

IPv4
1. At your workstation, open the Web browser and enter the IP Address of the machine in the 

Address Bar.
2. Press Enter.
3. Select Properties.
4. If prompted, enter the Administrator User Name (admin) and Password (1111), and select Login. 

Click Properties.
5. In the Network Settings link select TCP/IPv4 from the directory tree. The TCP/IPv4 page displays.
6. In the Assign IPv4 Address menu, select Automatically or Manually.
7. If Manually is selected, in the TCP/IP Settings area enter details of the machine in the following 

fields:
a. IPv4 Address
b. Subnet Mask
c. Gateway Address 
If Automatically is selected, select BOOTP or DHCP.

Notes:
• If BOOTP or DHCP mode is selected, you cannot change the IP Address, Network Mask, 

or Router/Gateway Address. Select Auto IP if required.
• New settings will not be applied until the machine is rebooted. Changing the machine’s 

TCP/IP setting may cause you to lose your connection to the machine.
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Network Installation: TCP/IP
8. In the Domain Name area:
a. Enter a domain name in the Domain Name field.
b. Enter an IP address in the Primary DNS Server and Secondary DNS Server fields.
c. Select the Enable check box to enable Dynamic DNS Registration if required.

Note: If your DNS Server does not support dynamic updates there is no need to select Enabled.

9. In the WINS area select the check box to enable WINS and enter details in the following fields:
a. Primary WINS Server
b. Secondary WINS Server

10. Select Apply to save the changes.
11. Select OK when the acknowledgement message displays.

IPv6
1. At your workstation, open the Web browser and enter the IP Address of the machine in the 

Address Bar.
2. Press Enter.
3. Select Properties.
4. If prompted, enter the Administrator User Name (admin) and Password (1111), and select Login. 

Click Properties.
5. In the Network Settings link, select TCP/IPv6 from the directory tree.
6. Select the Enable check box to enable IPv6 protocol and select OK.
7. To set a manual address, select Enable Manual Address and enter the address and prefix in the 

Address/Prefix area. Information in the Assigned IPv6 Addresses box is automatically 
populated.

8. The machine performs auto-address DHCPv6 configuration every time it powers up. This is used 
for neighbor discovery and address resolution on the local IPv6 subnet. However, you can choose 
to use manual configuration, automatic configuration or a combination of automatic and manual 
configuration.
In the Dynamic Host Configuration Protocol Version 6 (DHCPv6) area, select one of the 
following options:
• Use DHCP as directed by a router - this option is fully automatic. The DHCPv6 Address will 

be obtained and displayed on the screen.
• Always Enable DHCP - this option is fully automatic. The DHCPv6 Address will be obtained 

and displayed on the screen.
• Never use DHCP - when this option is selected, you must configure the Manual Address 

Options and DNS separately.
9. In the Domain Name System Version 6 (DNSv6) area:

a. Enter valid details in the IPv6 Domain Name field.
b. Enter an IP addresses for the Primary DNSv6 Server Address and Secondary DNSv6 Server 

Address.
c. Check the Dynamic DNSv6 Registration check box to enable this option.

Note: If your DNS Server does not support dynamic updates there is no need to enable DDNS.

10. Select Apply to save the changes.
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Network Installation: TCP/IP
11. Select OK when the acknowledgement message displays.

Note: Enabling or disabling the TCP/IPv6 protocol will take effect after the system is rebooted. 
Enabling or disabling TCP/IPv6 will impact other protocols, for example LPR/LPD, SNMP, Raw 
TCP/IP Printing and DHCPv6 over TCP/IPv6.

Test Access
1. At your workstation, open the Web browser and enter the TCP/IP Address of the machine in the 

Address bar. Press Enter.
If you use the domain name to specify the machine, use the following format.
http://myhost.example.com
If you use the IP address to specify the machine, use one of the following formats depending on 
your machine configuration. An IPv6 address needs to be enclosed in square brackets.
IPv4: http://xxx.xxx.xxx.xxx
IPv6: http://[xxxx:xxxx:xxxx:xxxx:xxxx:xxxx:xxxx:xxxx]

Note: If you have changed the port number from the default port number 80, append the number 
to the Internet address as follows. In the following examples, the port number is 8080.

Domain name: http://myhost.example.com:8080
IPv4: http://xxx.xxx.xxx.xxx:8080
IPv6: http://[xxxx:xxxx:xxxx:xxxx:xxxx:xxxx:xxxx:xxxx]:8080

2. Verify that the home page of CentreWare Internet Services displays.

The CentreWare Internet Services installation process is complete.

Note: When your access to CentreWare Internet Services is encrypted, enter https:// followed by 
the Internet address, instead of http://.
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Network Installation: Unix
Network Installation: Unix

HP-UX Client (Version 10.x)

HP-UX workstations require specific installation steps to communicate with the machine. The machine 
is a BSD-style Unix printer, whereas HP-UX is a System V-style Unix. 

IMPORTANT: All Unix commands are case sensitive, so enter the commands exactly as they are 
written.

Information Checklist

Before starting, ensure that the following items are available and/or the tasks have been performed:
• Existing operational network utilizing the TCP/IP protocol.
• Ensure that the machine is connected to the network.
• Static IP Address for the machine.
• Subnet Mask Address for the machine.
• Gateway Address for the machine.
• Host Name for the machine.

Procedure

Follow the steps in Configure TCP/IP Settings using CentreWare CentreWare Internet Services, then 
return to this page.

Configure the Client
1. Add the machine Host Name to the etc/hosts file on the HP-UX workstation.
2. Ensure that you can ping the machine from the HP-UX workstation.
3. Use either the GUI method or the tty methods as detailed below.

GUI Method
1. Open a Command window from the desktop.
2. Enter su to access Super User mode.
3. Enter sam to start the System Administrator Manager (SAM).
4. Select the Printers and Plotters icon.
5. Select lp spooler.
6. Select Printers and Plotters.
7. Select Actions > Add Remote Printer/Plotter.
8. Enter the following information into the Add Remote Printer/Plotter form:

a. Printer Name: printer name. 
Where printer name is the name of the queue being created.

b. Remote System Name: hostname.
Where hostname is the machine hostname from the /etc/hosts file.
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Network Installation: Unix
c. Select Remote Printer is on a BSD System.
d. Select OK to complete the form.

9. Select Yes at the Configure HP UX Printers Subpanel screen. This screen may be obscured by the 
Add Remote Printer/Plotter form.

10. Select File >Exit.
11. Select File> Exit Sam.
12. Enter Exit to exit Super User mode.
13. Test the queue created, by entering the command: 

lp -d queuename /etc/hosts
14. Verify that the job prints at the machine.

tty Method
1. Enter su to access Super User mode.
2. Enter sh to run the Bourne shell.
3. Enter lpshut to stop the print service.
4. Create the print queue by typing (on the same command line):

lpadmin -pqueuename> -v/dev/null -mrmodel -ocmrcmodel -osmrsmodel -ob3 -orc -
ormhostname -orplp

Where queuename is the name of the queue being created and hostname is the machine 
hostname.

5. Enter lpsched to start the print service.
6. Enter enable queuename to enable the queue to print to the machine.
7. Enter accept queuename to the queue accepting jobs from the HP-UX workstation.
8. Enter Exit to exit the Bourne shell.
9. Enter Exit to exit Super User mode.
10. Test the queue created, by entering the command:

lp -d queuename /etc/hosts
11. Verify that the job prints at the machine.
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Network Installation: Unix
Solaris 9 and later

Information Checklist

Before starting, ensure that the following items are available and/or the tasks have been performed:
• Existing operational network utilizing the TCP/IP protocol.
• Ensure that the machine is connected to the network.
• Static IP Address for the machine.
• Subnet Mask Address for the machine.
• Gateway Address for the machine.
• Host Name for the machine.

Procedure

Follow the steps in Configure Static IPv4 Addressing Using the Machine User Interface then return to 
this page.

Configure the Client
1. Add the machine printer Host Name to the etc/hosts file.
2. Ensure that you can ping the machine.
3. Use either the GUI method or the tty method as detailed below.

GUI Method
1. Open a Command window from the desktop.
2. Enter su to access Super User mode.
3. Enter admintool to run the System Administrator Tool.
4. Select Browse > Printers.
5. Select Edit > Add:Access to Printer.
6. Enter the following information into the Access to Remote Printer form:

a. Printer Name: queuename. 
Where queuename is the name of the queue being created.

b. Print Server: hostname. 
Where hostname is the machine hostname from the /etc/hosts file. 

c. Select OK to complete the form.
7. Enter sh to run the Bourne shell.
8. Enter the command: lpadmin -p queuename -s hostname !lp to modify the remote queuename
9. Enter Exit to exit the Bourne shell.
10. Enter Exit to exit Super User mode.
11. Test the queue created, by entering the command: 

lp -d queuename /etc/hosts
12. Verify that the job prints at the machine.
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Network Installation: Unix
tty Method
1. Enter su to access Super User mode.
2. Enter sh to run the Bourne shell.
3. Define the machine as a BSD style printer, by entering the command: 

lpsystem -t bsd hostname
Where hostname is the machine hostname from the /etc/hosts file.

4. Create the queue, by entering the command:
lpadmin -p queuename -s hostname -T unknown -I any
where queuename is the name of the queue being created.

5. Enter Exit to exit the Bourne shell.
6. Enter Exit to exit Super User mode.
7. Test the queue created, by entering the command: 

lp -d queuename /etc/hosts
8. Verify that the job prints at the machine.

SCO

SCO Unix workstations require specific installation steps to communicate with the machine. The 
machines are BSD-style Unix printers, whereas SCO is a System V-style Unix.

Information Checklist

Before starting, ensure that the following items are available and/or the tasks have been performed:
• Existing operational network utilizing the TCP/IP protocol.
• Ensure that the machine is connected to the network.
• Static IP Address for the machine.
• Subnet Mask Address for the machine.
• Gateway Address for the machine.
• Host Name for the machine.

Procedure

Follow the steps in Configure Static IPv4 Addressing Using the Machine User Interface then return to 
this page.

Configure the Client
1. Add the machine printer Host name to the etc/hosts file on the SCO workstation.
2. Ensure that you can ping the machine from the SCO workstation. 

Perform the following steps to create a machine print queue on a SCO Unix workstation using 
either the GUI or the TTY method.

GUI Method
1. Log in as root.
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Network Installation: Unix
2. From the main desktop, select the icons System Administration: Printers: Printer Manager.
3. Select Printer > Add Remote: Unix.
4. Enter the following information into the Add Remote Unix Printer form:

a. Host: hostname.
Where hostname is the machine Host Name from the /etc/hosts file.

b. Printer: name of the queue being created.
For example: dc xxxq.

c. Select OK to complete the form.
5. Select OK in the Message window.
6. Select Host > Exit.
7. Select File> Close this directory.
8. Select File >Close this directory.
9. Select Save in the Warning Confirmation window.
10. Enter Exit to log out of root account.
11. Open Unix Window.

tty Method
1. Enter su to access Super User mode.
2. Enter rlpconf to create a printer.
3. Enter the following information:

a. Printer Name: queuename
b. Remote Printer: r
c. Hostname: hostname
d. If the information has been entered correctly, enter y

4. Select Enter to accept the default for a non-SCO remote printer.
5. Select Enter to accept the default for non-default printer.
6. Select Enter to start the process for adding a queue.
7. Enter q to quit the rlconf program.
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Network Installation: Linux
Network Installation: Linux

Linux CUPS: Static Addressing

Information Checklist

Before starting, ensure that the following item is available and/or the task has been performed:
• Linux operating system that supports printtool.

Procedure

Follow the steps in Configure TCP/IP Settings Using CentreWare CentreWare Internet Services, then 
return to this page.

Create the Print Queue
1. Ensure that the Common Unix Printing System (CUPS) is installed and started on your client.

The latest version of CUPS is available at cups.org.
2. Open the Web browser from your workstation.
3. For example, enter http://127.0.0.1:631/printers in the Address Bar.
4. Press Enter.
5. Select Add Printer.
6. The Authorization dialog box displays. 
7. Enter the root and the root password.
8. In the Add New Printer screen enter a name for the printer.
9. Enter a location and description for the printer (optional).
10. Select Continue.
11. In the Machine menu, select Internet Printing Protocol.
12. Select Continue.
13. Enter ipp://hostname/ipp/printername

Where hostname is the hostname of the Xerox machine and printername is the printer name of 
the Xerox machine.

14. Select Continue.
15. Select Xerox in the Make menu.
16. Select Continue.
17. Select the correct driver in the Driver menu.
18. Select Continue.
19. The Printer Added Successfully message displays.
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Network Installation: Linux
Dynamic Addressing

Procedure

Follow the steps in Configure TCP/IP Settings Using CentreWare CentreWare Internet Services, then 
return to this page.

Important: Highlight BOOTP in step 6.

Create the Print Queue

Follow the steps to Create the Print Queue.

Linux LPR via PrintTool

Static Addressing

Information Checklist

Before starting ensure that the following item is available and/or the task has been performed:
• Linux operating system that supports PrintTool.

Procedure

Follow the steps in Configure TCP/IP Settings using CentreWare CentreWare Internet Services, then 
return to this page.

Create the Print Queue
1. Log in, at the Linux Client, as root in a terminal.
2. Enter printtool.
3. The Red Hat Linux Print System Manager will launch.
4. Select Add.
5. The Add a Printer Entry window displays.
6. Select Remote Unix (lpd) Queue.
7. Select OK.
8. The Edit Remote Unix (lpd) Queue Entry window displays. 
9. Enter the name of your Print Queue in the Names area.
10. The Spool directory is the directory where print jobs are stored and is a subdirectory of 

/var/spool/lpd. Add the name of the print queue to the end of the subdirectory path.
11. Ensure that the File Limit reads 0.
12. In the Remote Host area, enter the IP Address of the Xerox machine.
13. In the Remote Queue area, enter the Print Queue Name from step 10.
14. Do not select the Input Filter option.
15. Leave the default Suppress Headers selected. 
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Network Installation: Linux
16. Select OK.
17. The printer should now be listed in the Red Hat Linux Print System Manager window. Select the 

lpd menu.
18. Select Restart lpd.
19. Select the PrintTool menu.
20. Select Exit to close the program.
21. To allow access to the printer, edit the /etc/hosts table to list the client system.
22. Edit and create the /etc/hosts.lpd file to list the client system.

Dynamic Addressing

Procedure

Follow the steps in Configure TCP/IP Settings Using CentreWare CentreWare Internet Services, then 
return to this page.

Important: Highlight BOOTP in step 6.

Create the Print Queue

Follow the steps to Create the Print Queue.

Linux LPRng

Static Addressing

Information Checklist

Before starting, ensure that the following item is available and/or the task has been performed:
• Linux operating system that supports PrintTool. 

Procedure

Follow the steps in Configure Static IPv4 Addressing Using the Machine User Interface, then return to 
this page.

Create the Print Queue
1. Open the LPRngTool from the Linux Client.
2. Select Add.
3. In the Names area, enter a name for your print queue.
4. The spool directory is the directory where print jobs are stored and is a subdirectory of 

/var/spool/lpd. Add the name of the print queue to the end of the subdirectory path.
5. In the Hostname/IP of Printer area, enter the hostname or IP Address of the Xerox machine.
6. Select OK.
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Network Installation: Linux
7. Select Exit to close the program.
8. To allow access to the printer, edit the /etc/hosts table to list the client system.
9. Edit and create the /etc/hosts.lpd file to list the client system.

Dynamic Addressing

Procedure

Follow the steps in Configure TCP/IP Settings Using CentreWare CentreWare Internet Services, then 
return to this page.

Important: Highlight BOOTP in step 6.

Follow the steps to Create the Print Queue.
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Printer Drivers

The Xerox Phaser 3052/3260 produces high quality prints from electronic documents. You can access 
the printer from your computer by installing the appropriate printer driver. To access the many printer 
drivers which can be used with your machine, refer to the drivers CD or download the latest versions 
from the Xerox Web site at www.xerox.com.

You can install the printer software for local printing and network printing. To install the printer 
software on the computer, perform the appropriate installation procedure for the printer in use. The 
procedure to install drivers may differ depending on the operating system you are using. All 
applications should be closed on your PC before beginning installation.

This section explains how to install the printer drivers on your computer.

Overview

The software and documentation CD is supplied with your machine. 

The machine supports the following operating systems:

Platform Operating Systems

Windows® Windows 7 & 8 (32/64 bit)
Windows Vista (32/64 bit)
Windows XP (32/64 bit)
Windows 2003 Server (32/64 bit)
Windows 2008 Server (32/64 bit)
Windows 2008R2 (64 bit)

Macintosh® Macintosh OS X 10.5 - 10.9

Linux Ubuntu 10.04, 10.10, 11.04, 11.10, 12.04, 12.10, 
13.04
Red Hat Enterprise Linux 5, 6
Fedora 11 -19
Debian 5.0, 6.0, 7.0, 7.1
Mint 13, 14, 15
SUSE Linux Enterprise Desktop 10, 11
openSUSE 11.0, 11.1, 11.2, 11.3, 11.4, 12.1, 12.2, 
12.3 

UNIX® Oracle® Solaris 9, 10, 11 (x86, SPARC)

HP-UX® 11i v1, 11i v2, 11i v3 (PA-RISC, Itanium)

IBM® AIX 5.1, 5.2, 5.3, 5.4, 6.1, 7.1 (PowerPC)
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Windows Drivers
Windows Drivers

Installing Windows Drivers

The following provides an overview of the print procedure and features available when printing using 
Windows.

Local Printer

A local printer is a printer directly attached to your computer using a printer cable, such as a USB cable. 
If your printer is attached to a network, refer to refer to Networked Printer.

Note: If the New Hardware Wizard window appears during the installation procedure, select 
Close or Cancel.

1. Make sure that the printer is connected to your computer and powered on.
2. Insert the supplied CD-ROM into your CD-ROM drive. The CD-ROM should automatically run, and 

an installation window appears. 
If the installation window does not appear, select Start and then Run. Type X:\Setup.exe, 
replacing X with the letter which represents your drive and select OK.
If you use Windows Vista, select Start > All programs > Accessories > Run, and type X:\Setup.exe. 
If the AutoPlay window appears in Windows Vista, select Run Setup.exe in the Install or run 
program field, and select Continue in the User Account Control window.

3. Select Install Software. A Printer Connection Type window displays.
4. Select USB connection. The Select Software to Install window displays.
5. Leave the default selections and select Next. The Installing Software window displays.
6. After the installation is finished, the Setup Completed window displays. 
7. Select Print a test page and select Finish.

If your printer is connected to the computer, a Test Print page prints. If the Test Print operation is 
successful, refer to the Print chapter of this guide. If the print operation failed, refer to the 
Troubleshooting chapter of this guide. 
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Networked Printer

When you connect your printer to a network, you must first configure the TCP/IP settings for the 
printer. After you have assigned and veUnmarkrified the TCP/IP settings, you are ready to install the 
software on each computer on the network.
1. Make sure that the printer is connected to your network and powered on.
2. Insert the supplied CD-ROM into your CD-ROM drive.

The CD-ROM should automatically run, and an installation window appears.
If the installation window does not appear, select Start and then Run. Type X:\Setup.exe, 
replacing X with the letter which represents your drive and select OK.
If you use Windows Vista, select Start > All programs > Accessories > Run, and type X:\Setup.exe. 
If the AutoPlay window appears in Windows Vista, select Run Setup.exe in Install or run program 
field, and select Continue in the User Account Control window.

3. Select Install Software. A Printer Connection Type window displays.
4. Select Network connection. The Select Software to Install window displays.
5. After the installation is finished, the Setup Completed window displays.
6. After the installation is finished, select Print a test page and select Finish.

Note: For custom install instructions, refer to Custom Installation.

If your printer is connected to the computer, a Test Print page prints. If the Test Print operation is 
successful, refer to the Print chapter of this guide. If the print operation failed, refer to the 
Troubleshooting chapter of this guide. 
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Custom Installation

With the custom installation, you can choose individual components to install.
1. Make sure that the printer is connected to your computer and powered on.
2. Insert the supplied CD-ROM into your CD-ROM drive.

The CD-ROM should automatically run, and an installation window appears. If the installation 
window does not appear, select Start and then Run. Type X:\Setup.exe, replacing "X" with the 
letter which represents your drive and select OK.
If you use Windows Vista, select Start > All Programs > Accessories > Run, and type X:\Setup.exe.

Note: If the AutoPlay window appears in Windows Vista, select Run Setup.exe in the Install or 
run program field, and select Continue in the User Account Control window.

3. Select Install Software. A Printer Connection Type window displays.
4. Select your connection type and select Next. The Select Software to Install window displays.
5. Select Custom from the Setup type drop-down box.
6. Select the components to be installed and select Next. 

Note: When you select an option, a description of that option displays at the bottom of the 
screen.

7. Select Advanced Options if you would like to do any of the following:
• Change the printer name
• Change the default printer
• Share the printer with other users on the network
• Change the destination path where driver files and user guide files will be copied to. Click 

Browse to change the path.
8. Select OK to continue, then select Next. The Copying Files window displays, and followed by the 

Installing Software window.
9. After the installation is finished, the Setup Completed window displays. 
10. Select Print a test page and select Finish.

If your printer is connected to the computer, a Test Print page prints. If the Test Print operation is 
successful, refer to the Print chapter of this guide. If the print operation failed, refer to the 
Troubleshooting chapter of this guide. 

Wireless Printer 

When you connect your printer to a network, you must first configure the TCP/IP settings for the 
printer. After you have assigned and verified the TCP/IP settings, you are ready to install the software 
on each computer on the network.
1. Make sure that the printer is connected to your computer with a USB cable and powered on.
2. Insert the supplied CD-ROM into your CD-ROM drive. The CD-ROM should automatically run, and 

an installation window appears.
If the installation window does not appear, select the Start button and then Run. Type 
X:\Setup.exe, replacing X with the letter which represents your drive and select OK.
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If you use Windows Vista, select Start > All Programs > Accessories > Run, and type X:\Setup.exe. 
If the AutoPlay window appears in Windows Vista, select Run Setup.exe in Install or run program 
field, and select Continue in the User Account Control window.

3. Select Install Software. A Printer Connection Type window displays.
4. Select Wireless network connection.
5. When asked if you are setting up the printer for the first time, select Yes, I will set up my printer’s 

wireless network and click Next.
6. Select your wireless network from the list and click Next.
7. If required, click Advanced Settings to set the following.
8. Click Next. The Select Software to Install window displays.
9. After the installation is finished, select Print a test page and select Finish.

If your printer is connected to the computer, a Test Print page will be printed. If the Test Print operation 
is successful, refer to the Print chapter of this guide. If the print operation failed, refer to the 
Troubleshooting chapter of this guide. 
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Wireless Setting Program

When installing the Phaser 3052NI, 3260DI, and 3260DNI you can use the Xerox Easy Wireless Setup 
program that was automatically installed with the printer driver to configure the wireless settings.

To Open the Program
1. Select Start > Programs or All Programs > Xerox Printers > [Xerox Phaser 3052 or 3260]> Xerox 

Easy Wireless Setup.
2. Connect the machine to your computer using the USB cable.

Note: During installation, the printer needs to be temporarily connected using the USB cable.

Note: You cannot use your printer on a wired and wireless network at the same time. If your 
printer is currently connected to the network with an Ethernet cable, unplug the cable.

3. Select Next.
4. Once the machine is connected to the computer with the USB cable, the program searches for 

WLAN data.
5. When the search is complete, the Select Wireless Network window displays. Select your network 

from the list.
6. Click Advanced Setting if you want to enter the following information:
7. Click Next. The Wireless Network Security screen displays.
8. Enter your Network Password and click Next.
9. Click Finish when the setup is complete.
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Uninstalling a Windows Driver

For Windows, follow the steps below to uninstall the driver.

1. Make sure that the machine is connected to your computer and powered on.
2. From the Start menu, select Programs or All Programs > Xerox Printers > Uninstall Xerox Printer 

Software. The Uninstall Xerox Printer Software window displays.
3. Click Next. The Select Software window displays.
4. Select the components you want to remove and then select Next and then Yes to confirm.
5. When your computer asks you to confirm your selection, select Yes. The Uninstallation window 

displays.
6. After the software is removed, select Finish. 

If you want to reinstall the driver over the currently installed driver via the provided Software and 
Documentation CD, insert the CD; the window with an overwriting confirmation message appears. 
Simply confirm it to proceed to the next step. Next steps are same as the first installation you 
performed.

A TWAIN driver is also provided for scanning on a Macintosh computer.
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Macintosh Drivers

The Software and Documentation CD that came with your machine provides you with the Driver files 
that allow you to use the CUPS driver or PostScript driver (only available when you use a machine 
which supports the PostScript driver) for printing on a Macintosh computer.

A TWAIN driver is also provided for scanning on a Macintosh computer.

Information Checklist

Before starting, ensure that the following has been performed:
• Make sure that the machine is connected to your computer and powered on.

Procedure

These steps were performed using Macintosh version 10.8.5. Instructions may vary depending on your 
operating system version. 

1. Insert the supplied software and documentation CD into your CD-ROM drive.
2. Select the CD-ROM icon that appears on your Macintosh desktop.
3. Select the MAC_Installer folder.
4. Select the Installer icon.
5. The Install window opens. Select Continue.
6. Select Install.

Standard Install is the default and is recommended for most users. All components necessary for 
machine operations are installed. 
If you select Customize, you can choose individual components to install.

7. Enter your password and select Install Software.
8. Select how the printer will be connected to your computer. Choices are:

• USB Connected Printer
• Network Connected Printer
• Configuration of Wireless Network

9. Select Continue.
10. Select Add Printer and click Continue and follow the instructions on the installation wizard.
11. Select the options you want to add, such as Fax. 
12. Select the Add Easy Printer Manager to Dock option if required.
13. After the installation is complete, select Close.
14. Select tApplications > System Preferences > Print & Scan.
15. Select the + sign on the Printer list and select the printer or enter the IP Address for the printer.
16. Select Add. 
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Uninstalling Macintosh Driver

If the printer driver does not work properly, uninstall the driver and reinstall it. Follow the steps below to 
uninstall the driver for Macintosh.

1. Make sure that the machine is connected to your computer and powered on.
2. Click the Applications folder.
3. Click the Xerox folder.
4. Click Printer Software Uninstaller.
5. Select the programs you want to uninstall and click Uninstall.
6. Enter your password.
7. Select Close.
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Linux Drivers

You need to download the Linux software package from the Xerox Web site to install the printer 
software.

Procedure for Installing the Linux Unified Driver

1. Make sure that the machine is connected to your computer and powered on.
You must log in as a super user (root) to install the machine software. If you are not a super user, 
ask your system administrator. 

2. When the Administrator Login window appears, type root in the Login field and enter the system 
password. 

3. From the Xerox Web site, download the Unified Linux Driver package to your computer.
4. Select the Unified Linux Driver package and extract the package.
5. Select cdroot > autorun.
6. When the Welcome screen appears, select Next.
7. When the installation is complete, select Finish.

The installation program has added the Unified Driver Configuration desktop icon and the Unified 
Driver group to the system menu for your convenience. If you have any difficulties, consult the on-
screen help that is available through your system menu or called from the driver package Windows 
applications, such as Unified Driver Configurator or Image Manager.
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Unix Drivers

Unix printer drivers are located on the Software and Documentation CD delivered with your machine. 
To use the Unix printer driver, you need to install the Unix printer driver package first, then set up the 
printer. The installation procedure is common for all variants of Unix OS mentioned.

Procedure for Installing the Unix Driver Package

1. Make sure that the machine is connected to your computer and powered on.
2. Acquire root privileges.

su -
3. Copy the appropriate driver archive to the target Unix computer.
4. Unpack the Unix printer driver package name.

For example, on IBM AIX, use the following command:
gzip -d < package archive name | tar xf -
The binaries folder consists of binz, install, share files and folders.

5. Change to the driver’s binaries directory.
For example, on IBM AIX, 
cd aix_power/binaries

6. Run the install script.
./install
Install is the installer script file which is used to install or uninstall the Unix Printer Driver package. 
Use chmod 755 install command to give the permission to the installer script. 

7. Execute the ./install-c command to verify installation results.
8. Run installprinter from the command line. This will bring up the Add Printer Wizard window. 

Follow the procedures in Setting up the printer.

Note: On some Unix OS, for example on Solaris 10, printers recently installed may not be enabled 
and/or may not accept jobs. In this case run the following two commands on the root terminal:

accept <printer_name>
enable <printer_name>

Setting Up the Printer

To add the printer to your Unix system, run installprinter from the command line. This will bring up the 
Add Printer Wizard window. Set up the printer in this window according to the following steps.

1. Type the name of the printer.
2. Select the appropriate printer model from the model list.
3. Enter any description corresponding to the type of printer in the Type field. This is optional.
4. Specify any printer description in the Description field. This is optional. 
5. Specify the printer location in the Location field. 
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Unix Drivers
6. Type the IP address or DNS name of the printer in the Device textbox for network connected 
printers. On IBM AIX with jetdirect Queue type, only the DNS name is possible. It is not possible 
to enter a numeric IP address. 

7. Queue type shows the connection as lpd or jetdirect in the corresponding list box. Additionally 
USB type is available on Sun Solaris OS. 

8. Select Copies to set the number of copies. 
9. Check the Collate option to receive copies already sorted.
10. Check the Reverse Order option to receive copies in the reverse order.
11. Check the Make Default option to set this printer as default.
12. Click OK to add the printer. 

Uninstalling the Printer Driver Package
Note: The utility should be used if you need to delete a printer installed on the system.

1. Run the uninstallprinter command from the terminal. The Uninstall Printer Wizard opens and the 
installed printers are n the drop-down list.

2. Select the printer to be deleted.
3. Click Delete to delete the printer from the system.
4. Execute the ./install-d command to uninstall the whole package. 
5. To verify removal results, execute the ./install-c command.
6. To re-install it, use the command ./install to reinstall the binaries. 
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Sharing Your Machine Locally

If a host computer is directly connected to the machine with a USB cable and is also connected to the 
local network environment, the client computer connected to the local network can use the shared 
machine through the host computer to print.

Follow the steps below to set up the computers to share your machine locally.

Windows

Host Computer Setup

1. Install your printer driver. Refer to Printer Drivers.
2. Depending on your operating system, navigate to the Printers, Printers and Faxes, or Devices 

and Printers settings from the Windows Start Menu or through the control panel:
3. Select your printer icon and select Printer Properties.

Note: If the Printer properties item has a ?, you can select other printer drivers connected with 
the selected printer.

4. Select the Sharing tab.
5. Check the Change Sharing Options check box.
6. Check the Share this printer check box.
7. Enter details in the Share Name field.
8. Select OK or Next.

Client Computer Setup

1. Install your printer driver. Refer to Printer Drivers.
2. From the Windows Start menu, select All programs > Accessories > Windows Explorer.
3. Enter the IP address of the host computer and press Enter.
4. If the host computer requires a User name and Password, enter details in the User ID and 

password field of the host computer account.
5. Select the printer icon you want to share and select Connect.

If a set up complete message appears, select OK. 
6. Open the file you want to print and start printing. 
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Macintosh

The following steps are for Macintosh OS X 10.8.5. Refer to Macintosh Help for other OS versions.

Host Computer Setup

1. Install your printer driver. Refer to Installing Macintosh Driver.
2. Open the Applications folder, select System Preferences and select Print & Fax or Print & Scan.
3. Select the printer to share in the Printers list. 
4. Select Share this printer.

Client Computer Setup

1. Install your printer driver. Refer to Installing Macintosh Driver.
2. Open the Applications folder, select System Preferences and select Print & Fax or Print & Scan. 
3. Select Add or the + symbol. 

A display window showing the name of your shared printer displays.
4. Select your machine and select Add. 
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Windows Printing

LPR Printing

Ensure Print Services for Unix Is Enabled

Follow the relevant steps below that are specific to your operating system:

Windows 2003

1. From the desktop, select the My Network Places icon and select Properties. 
2. Select the Local Area Connection icon and select Properties.
3. Verify that the Internet Protocol (TCP/IP) protocol has been loaded. If this software is not present, 

install it using the documentation provided by Microsoft. When you are finished, return to this 
page.

4. Verify that Print Services for Unix is loaded: 
a. Select Start, Settings then Control Panel.
b. Select the Add/Remove Programs icon.
c. Select Add/Remove Win Components in the far left column.
d. Select Other Network File and Print Services.
e. Select Details.
f. Check the Print Services for Unix check box. If Print Services for Unix is not installed, refer to 

instructions from Microsoft to install this service. When you are finished, return to this page.
5. Select the OK button.
6. Select the Next button.
7. Select the Finish button.
8. Close the Add/Remove Programs window.

Windows Vista

1. Select Start > Control Panel > Program and select Programs and Features.
2. Select Turn Windows Features on and off.
3. In the Windows Features window, expand the Print Services menu.
4. Check the LPR Port Monitor check box to enable the service.
5. Select the OK button. Your computer may need to restart.

Windows 7

1. Select Start and select Control Panel.
2. Select Hardware and Sound and select Programs.
3. Select Programs and Features.
4. Select Turn Windows Features on and off from the menu on the left.
5. A Windows Features dialog displays. Select the + sign for Print and Document Services.
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Windows Printing
6. Check the check box for LPR Port Monitor to enable the service.
7. Select the OK button. Your computer may need to restart.

Windows 2008

1. Select Start > Administrative Tools.
2. Select Print Management.
3. Select the + sign for Print Servers. Select the print server to which you want to add the printer and 

select Add Printer.
4. Check the check box for LPR Port Monitor to enable the service.
5. Select the OK button. Your computer may need to restart.

Install Printer Driver

1. From the Windows Start menu, navigate to your Devices and Printers or Printers settings.
2. Select Add a Printer.
3. Select the Local Printer option.

Depending on your operating system, if already selected, select Automatically detect and install 
my Plug and Play printer to deselect it.

4. Select the local printer and click Next.
5. Select Create a new port.
6. Select the LPR option from the Type of Port pull-down menu:
7. Select the Next button.
8. Enter the IP Address of the printer.
9. Enter a name for the printer.
10. Select the OK button.
11. You will be prompted for a Printer Driver. Select Have Disk.
12. Select the Browse button. 
13. Select the required Printer Driver file .inf.
14. Select the Open button.
15. Select the OK button.
16. Select the printer model from the list.
17. Select the Next button.
18. The Name your Printer screen appears.
19. Enter details in the Printer name field.
20. Select the Next button. The Printer Sharing screen appears.
21. Select the Do not share or Share option and enter the name, location, and comment, if required.
22. Select the Next button.
23. Select Set as the default printer if required.
24. Select Print Test Page to print a test page.
25. Select the Finish button. The printer driver will install.
26. Verify that the test page is printed at the machine.
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Internet Printing Protocol (IPP) Port

The Internet Printing Protocol (IPP) defines a standard protocol for printing as well as managing print 
jobs, media size, resolution, and so forth. IPP can be used locally or over the Internet, and also supports 
access control, authentication, and encryption, making it a much more capable and secure printing 
solution than older ones.

Note: IPP Printing is enabled by default.

How to Enable the IPP Port

1. At your workstation, open the Web browser and enter the IP Address of the machine in the 
Address Bar.

2. Select Properties.
3. If prompted, enter the Administrator User Name (admin) and Password (1111), and select Login. 

Select Properties.
4. In the Network Settings link select Raw TCP/IP, LPR, IPP in the directory tree.
5. In the Internet Printing Protocol (IPP) area:

a. For IPP Protocol, select Enable from the drop-down menu. The Printer URI displays the 
http:// IP address of the machine and the ipp:// IP address of the machine. Enter the required 
printer name in the Printer Name area.

b. Select the Advanced button. Enter the required information for IPP Attribute.

Install Printer Driver

1. Follow the steps below that are specific to your operating system:
Windows 2003
From your workstation:
a. Select the My Network Places icon.
b. Select Properties. 
Windows 7
From your workstation:
a. Select Control Panel.
b. Select Network and Internet. 
c. Select Network and Sharing Center.
d. Select Change adapter settings.
Windows 2008
From your workstation:
a. Select Start, select Control Panel.
b. Select Printers.
c. Select File, select Run as administrator. Go to step 6.

2. Select the Local Area Connection icon.
3. Select Properties.
4. Ensure that the Internet Protocol (TCP/IP) protocol has been loaded and ensure the check box is 

checked. Select OK.
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5. For:
• Windows 2003 - select Settings >Printers.
• Windows Vista - select Add a Local Printer.
• Windows 7 - select Start > Control Panel > Hardware and Sound > Devices and Printers.

6. Select Add a Printer in the far left column.
For Windows 7 select Add a network, wireless or Bluetooth printer.

7. The Add Printer Wizard window displays. Select the Next button.
8. Select The Printer that I want isn’t listed.
9. Select a shared printer by name.
10. Type HTTP:// followed by the printer's fully qualified Domain name or IP Address in the URL field. 

The Printer Name can be either the Host Name or the SMB Host Name as shown on the machine 
Configuration Report, depending on the name resolution used by your network (WINS or DNS).

11. Select the Next button.
12. Select the Have Disk button and browse to the location of the printer driver and select the OK 

button.
13. Select the Printer Model and Select the OK button.
14. Select Yes if you wish to make this the default printer.
15. Select Next.
16. Select Finish.

Raw TCP/IP Printing (Port 9100)

Raw TCP/IP is a printing protocol that is similar to LPR printing. Also known as a direct TCP/IP 
connection or sockets interface, it sends information directly to the machine and does not require a 
Line Printer Daemon (LPD). The advantages are that connections stay open for multiple print files and 
spooling is not needed, therefore, printing is faster and more reliable than LPD printing. Raw TCP/IP 
printing is contained in Windows and other third-party applications and operating systems.

Note: Raw TCP/IP Printing is enabled by default for port 9100.

Information Checklist

See the Information Checklist in Configure TCP/IP Settings Using CentreWare CentreWare Internet 
Services.

How to Configure Port 9100

1. At your workstation, open the Web browser and enter the IP Address of the machine in the 
Address Bar.

2. Select Properties.
3. If prompted, enter the Administrator User Name (admin) and Password (1111), and select Login. 

Select Properties.
4. In the Network Settings link select Raw TCP/IP, LPR, IPP in the directory tree.
5. In the Raw TCP/IP Printing area:

a. Select Enable.
Xerox® Phaser® 3052/3260
User Guide

49

Download from Www.Somanuals.com. All Manuals Search And Download.



Windows Printing
b. For Port Number, enter the required port number (1 - 65535).
6. Select Apply to save the changes or Undo to return the settings to their previous values.

Note: The settings are not applied until you restart the machine.

Install Printer Driver

Refer to Printer Drivers.

Configure the Windows Printer Driver

Manual Print Driver Configuration

To configure the printer driver without using Bi-directional communication:

Follow the steps below:

1. Select the Windows Start menu.
2. Depending on your Operating System, navigate to the Printers or Devices and Printers setting.
3. Select the printer icon and then select Printing preferences.
4. Select each tab and change any default printer settings as required.
5. Select Apply.
6. Select OK.

Bi-Directional Support

Follow the steps below that are specific to your operating system:

1. Select the Windows Start menu.
2. Depending on your Operating System, navigate to the Printers or Devices and Printers setting.
3. Select the printer icon and then select Printer properties.
4. Select the Ports tab.
5. Check the Enable bidirectional support check box. 

Bi-directional communication automatically updates the printer driver with the printer's installed 
options. The driver’s Printing Preferences will report information about the printer's operational 
status, active jobs, completed jobs and paper status.

6. Select OK.
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AirPrint

AirPrint is a software feature that allows for driverless printing from Apple iOS-based mobile devices 
and Macintosh OS-based devices. AirPrint-enabled printers let you print directly from a Macintosh or 
from an iPhone, iPad, or iPod touch.

Notes:
• Not all applications support AirPrint.
• Wireless devices must join the same wireless network as the printer.
• For AirPrint to function, both IPP and Bonjour (mDNS) protocols must be enabled. 
• The device that submits the AirPrint job must be on the same subnet as the printer. To allow 

devices to print from different subnets, configure your network to pass multicast DNS traffic 
across subnets.

• AirPrint-enabled printers work with iPad (all models), iPhone (3GS or later), and iPod touch 
(3rd generation or later), running the latest version of iOS.

• The Macintosh OS device must be Macintosh OS 10.7 or later.
1. Open a Web browser, type the IP address of the printer, then press Enter or Return.
2. Click Login and enter the ID (admin) and Password (1111).
3. Click Properties > Network Settings > AirPrint.
4. To enable AirPrint, click Enable.

Note: AirPrint is enabled by default when IPP and Bonjour (mDNS) are both enabled. Enable 
these settings by selecting Properties > Network Settings > Raw TCP/IP, LPR, IPP and Properties 
> Network Settings > mDNS.

5. To change the printer name, in the Friendly Name field, enter a new name.
6. To enter a location for the printer, in the Location field, enter the location of the printer
7. To enter a physical location for the printer, in the Geographical Location field, enter the 

geographic Latitude and Longitude coordinates in decimal form. For example, use coordinates 
such as +170.1234567 and +70.1234567 for a location.

8. Click Apply.
9. For the new settings to take effect, restart your printer.
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Google Cloud Print

Google Cloud Print is a service that allows you to print to a printer using your smart phone, tablet, or 
any other Web-connected devices. Just register your Google account with the printer, and you are 
ready to use the Google Cloud Print service. You can print your document or e-mail with Chrome OS, 
Chrome browser, or a Gmail™/ Google Docs™ application on your mobile device, so you don’t need to 
install the printer driver on the mobile device. Refer to the Google Web site at 
http://www.google.com/cloudprint/learn/ or http://support.google.com/cloudprint for more  
information about Google Cloud Print.

Notes:
• Make sure the printer is turned on and connected to a wired or wireless network that has 

access to the Internet.
• Depending on your security configuration, your firewall might not support Google Cloud Print.
• Set up a Google e-mail account.
• Configure the printer to use IPv4.
• Configure Proxy Server settings as needed.

1. Open a Web browser, type the IP address of the printer, then press Enter or Return.
2. Click Login and enter the ID (admin) and Password (1111).
3. Click Properties > Network Settings > Google Cloud Print.
4. To change the printer name, enter a new name in the Printer Name field.
5. If you need to enable a proxy server, select Proxy Setting and enter your proxy informaion.
6. Select Test Connection to ensure your connection with the printer is successful.
7. Click Register to register the device to Google Cloud Print. 

Note: If the Claim Url link does not display when you click Register, refresh the CentreWare 
Internet Services page and click Register.

8. Click the Claim Url that displays. This takes you to the Google Cloud Print Web site to finish the 
registration.

9. Click Finish printer registration.
10. Now your printer is registered with Google Cloud Print. Click Manage your printer. Google Cloud 

Print ready devices display in the list.
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3Paper and Media

This chapter contains information about the different types of stock and stock sizes that can be used 
on your machine, available paper trays, and the types of stock and sizes supported by each tray.

This chapter includes: 
• Loading Paper
• Setting Paper Size and Type and Source
• Media Specifications
• Media Output Locations
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Loading Paper

One paper tray and a manual feed slot are standard on your machine.

Various media sizes and types can be used in the trays. For more media specifications, refer to Media 
Specifications.

Preparing Paper for Loading

Before loading paper into the paper trays, flex or fan the 
edges of the paper stack. This procedure separates any sheets 
of paper that are stuck together and reduces the possibility of 
paper jams. 

Note: To avoid unnecessary paper jams and misfeeds do 
not remove paper from its packaging until required.

Loading Tray 1

The paper level indicator on the front of tray 1 shows the 
amount of paper currently left in the tray. When the tray is 
empty, the indicator is completely lowered as shown in the 
illustration: 1 shows full, 2 shows empty.

Using the instructions provided below, load paper into the 
machine. Tray 1 holds up to 250 sheets of 20 lb (80 g/m²) 
paper, A4 and letter only. It holds fewer sheets of other media 
sizes. For more media specifications, refer to Media 
Specifications.

1. Pull out tray 1 and load paper into the tray, print side 
down. Do not fill above the Maximum Fill line indicated 
by the symbol . 
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Loading Paper
2. To accomodate longer paper, press the paper tray 
extender lever (1) and slide the lever to the desired 
position. Press and slide the paper length guide (2) until 
it lightly touches the end of the paper stack.

3. Position the width guide by pressing the lever and sliding 
it towards the stack of paper, until it gently touches the 
side of the stack.

4. Insert the paper tray into the machine.
5. After loading paper in the paper tray, ensure you select 

the Paper tab in the print driver to specify the correct 
paper size and type. Not confirming the paper details 
may result in printing delays. 

Using the Manual Feed Slot

The manual feed slot is located on the front of your machine. It can be closed when not in use, making 
the product more compact. Use the manual feed slot to print transparencies, labels, envelopes or 
postcards in addition to making quick runs of paper types or sizes that are not currently loaded in the 
paper tray.

When using the manual feed slot for special media, it may be necessary to use the rear cover for the 
output. For further information refer to Media Output Locations.

Acceptable print media is plain paper from 3.0 x 5.0 inches to 8.5 x 14 inches Legal (76 mm x 127 mm 
to 216 mm x 356 mm) and weighing between 16 lb and 58 lb (60 g/m² and 220 g/m²). For more media 
specifications, refer to Media Specifications.
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Loading Paper
Loading the Manual Feed Slot
1. Press to open the manual feed slot, located on the front 

of the machine.

Note: The manual feed slot holds 1 sheet of the following 
media: 20 lb (80 g/m²) plain paper, transparency, label, 
envelope or cardstock.

2. Load the print material between the width guides with 
the print side facing up.

Note: Hold a transparency by the edge and avoid 
touching the print side.

3. Adjust the paper guide to the width of the print material. 

Note: If the media prints with curl, wrinkles, a crease, or 
black bold lines, open the rear cover and print again.

4. After loading paper in the paper tray, ensure you select 
the Paper tab in the print driver to specify the correct 
paper size and type. For the source, you must select 
Manual Feeder. Not confirming the paper details may 
result in printing delays.

Envelope Mode
1. Press to open the manual feed slot, located on the front 

of the machine. 
2. Remove any curl on the envelope before loading it into 

the manual feed slot. 

Note: For more information on media specifications, 
refer to Media Specifications.
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Loading Paper
3. Load the envelope short edge feed and with the flap 
facing down as shown in the illustration.

4. Adjust the paper guide to the width of the print material. 

Note: If the media prints with curl, wrinkles, a crease, or 
black bold lines, open the rear cover and print again.

5. After loading paper in the manual feed slot, ensure you 
select the Paper tab in the print driver to specify the 
correct paper size and type. For the source, you must 
select Manual Feeder. Not confirming the paper details 
may result in printing delays.

6. After printing, close the manual feed slot.
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Setting Paper Size and Type and Source

For printing, select the paper size and type in the application program you use on your computer.

Alternatively, to change the paper size and type on your computer, select Xerox Easy Printer Manager 
>  (Switch to advanced mode) > Device Settings.
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Media Specifications

Media Guidelines

When selecting or loading paper, envelopes, or other special media, adhere to these guidelines:
• Attempting to print on damp, curled, wrinkled, or torn paper can cause paper jams and poor print 

quality.
• Use only high quality copier grade paper. Avoid paper with embossed lettering, perforations or 

texture that is too smooth or too rough.
• Store paper in its ream wrapper until ready to use. Place cartons on pallets or shelves, not on the 

floor. Do not place heavy objects on top of the paper, whether it is packaged or unpackaged. Keep 
it away from moisture or other conditions that can cause it to wrinkle or curl. 

• During storage, moisture-proof wrap (any plastic container or bag) should be used to prevent dust 
and moisture from contaminating your paper.

• Always use paper and other media that conforms to the specifications.
• Use only well-constructed envelopes with sharp, well creased folds:

• DO NOT use envelopes with clasps and snaps.
• DO NOT use envelopes with windows, coated lining, self-adhesive seals, or other synthetic 

materials.
• DO NOT use damaged or poorly made envelopes.

• Only use the special media recommended for use in laser printers.
• To prevent special media such as transparencies and label sheets from sticking together, remove 

them from the exit tray as they are printed.
• Place transparencies on a flat surface after removing them from the machine.
• Do not leave the special media in the manual feed slot for long periods of time. Dust and dirt may 

accumulate on them resulting in spotty printing.
• To avoid smudging caused by fingerprints, handle transparencies and coated paper carefully.
• To avoid fading, do not expose the printed transparencies to prolonged sunlight.
• Store unused media at temperatures between 59°F and 86°F (15°C to 30°C). The relative humidity 

should be between 10% and 70%.
• When loading paper, do not fill above the Maximum Fill line indicated by the symbol .
• Verify that your labels adhesive material can tolerate fusing temperature of 200oC (392oF) for 0.1 

second.
• Ensure that there is no exposed adhesive material between labels. 

CAUTION: Exposed areas can cause labels to peel off during printing, which can cause paper 
jams. Exposed adhesive can also cause damage to machine components. 

• Do not feed a sheet of labels through the machine more than once. The adhesive backing is 
designed for one pass only through the machine.

• Do not use labels that are separating from the backing sheet or are wrinkled, bubbled, or 
otherwise damaged.
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Media Specifications
Media Types
Note: Some features may not be available on your model. Check your machine type in Getting 
Started.

The table below shows the media types supported for Print for each tray for the following paper sizes:

Key:

• A4 8.27 x 11.69 inches (210 x 297 mm)

• Letter 8.5 x 11.0 inches (216 x 279 mm)

• Legal 8.5 x 14.0 inches (216 x 355 mm)

• Oficio 8.5 x 13.5 inches (216 x 343 mm)

• Folio 8.5 x 13.0 inches (216 x 330 mm)

Types Supported Weights  Tray 1 Bypass 
Tray

Duplex 
Unit 

Plain  19 to 24 lb (70 to 90 g/m²) O O O

Thick 24 to 28 lb (91 to 105 g/m²) O O O

Thicker 43 to 58 lb (164 to 220 g/m²) X O X

Thin 16 to 18 lb (60 to 70 g/m²) O O O

Cotton 20 to 24 lb (75 to 90 g/m²) X O X

Colored 20 to 24 lb (75 to 90 g/m²) X O X

Preprinted 20 to 24 lb (75 to 90 g/m²) X O X

Recycled 19 to 24 lb (70 to 90 g/m²) O O O

Transparency
(A4 / Letter only)

37 to 39 lb (138 to 146 g/m²) X O X

Labels 32 to 40 lb (120 to 150 g/m²) X O X

Card Stock 32 to 43 lb (121 to 163 g/m²) O O X

Bond 28 to 32 lb (105 to 120 g/m²) O O O

Archival 28 to 32 lb (105 to 120 g/m²) if you 
need to keep the print-out for a long 
period time, such as archives, select 
this option

O O X

Supported Not SupportedO X
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The table below shows the media types supported for Print for each tray for the following paper sizes:

Key: 

• JIS B5 7.17 x 10.12 inches (182 x 257 mm)

• ISO B5 6.93 x 9.84 inches (176 x 250 mm)

• Executive 7.25 x 10.50 inches (184.2 x 266.7 mm)

• A5 5.85 x 8.27 inches (148.5 x 210 mm)

• A6 4.13 x 5.85 inches (105 x 148.5 mm)

• Postcard 4 x 6 inches (101.6 x 152.4 mm)

• Monarch Envelopes 3.88 x 7.5 inches (98.4 x 190.5 mm)

• DL Envelopes 4.33 x 8.66 inches (110 x 220 mm)

• C5 Envelopes 6.38 x 9.02 inches (162.0 x 229 mm)

• C6 Envelopes 4.49 x 6.38 inches (114 x 162 mm)

• No. 10 Envelopes 4.12 x 9.5 inches (105 x 241 mm)

Types Supported Weights  Tray 1 Bypass 
Tray

Duplex 
Unit

Plain  19 to 24 lb (70 to 90 g/m²) O O X

Thick  24 to 28 lb (91 to 105 g/m²) O O X

Thicker 43 to 58 lb (164 to 220 g/m²) X O X

Thin 16 to 18 lb (60 to 70 g/m²) O O X

Cotton 20 to 24 lb (75 to 90 g/m²) X O X

Colored 20 to 24 lb (75 to 90 g/m²) X O X

Preprinted 20 to 24 lb (75 to 90 g/m²) X O X

Recycled 19 to 24 lb (70 to 90 g/m²) O O X

Postcard 32 to 43 lb (121 to 163 g/m²) card stock X O X

Envelopes 20 to 24 lb (75 to 90 g/m²) X O X

Supported Not SupportedO X
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Media Output Locations

The machine has two output locations:
• Output tray, face down, up to a maximum of 150 sheets 

of 20 lb (80 g/m²) paper, 10 transparencies and 10 
sheets of labels.

Note: Only one transparency or label can be fed at a 
time. 

• Rear cover, face up, one sheet at a time.

The machine sends output to the output tray by default. If special media such as envelopes print out 
with wrinkles, curl, creases, or black bold lines, the rear cover should be used for the output. Open the 
rear cover and keep it open while printing one sheet at a time.

Note: The rear cover output can only be used for simplex jobs. Duplex printing with the rear door 
open will cause paper jams.

Using the Output Tray

The output tray collects printed paper face down, in the order in which the sheets were printed. The 
output tray should be used for most jobs.

To use the output tray, make sure that the rear cover is closed. 

Notes:
• If paper coming out of the output tray has problems, such as excessive curl, try printing 

to the rear cover.
• To reduce paper jams, do not open or close the rear cover while the printer is printing.
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Using the Rear Cover
Note: Some features may not be available on your 
model. Check your machine type in Getting Started.

When using the rear cover, paper comes out of the machine 
face up. Printing from the bypass tray to the rear cover 
provides a straight paper path and might improve the output 
quality when printing on special media. Whenever the rear 
cover is open, the output is delivered there.

Note: The rear cover output can only be used for simplex 
jobs. Duplex printing with the rear cover open causes 
paper jams.

CAUTION: The fuser area inside the rear cover of your machine becomes very hot when in use. 
Take care when you access this area.
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4Print

This product produces high quality prints from electronic documents. You can access the printer from 
your computer by installing the appropriate printer driver. To access the many printer drivers which can 
be used with your machine, refer to the driver CD or download the latest versions from the Xerox Web 
site at www.xerox.com.

This chapter includes:
• Printing using Windows
• Xerox Easy Printer Manager (EPM)
• Printing using Macintosh
• Printing using Linux
• Printing using Unix
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Printing Using Windows
Printing Using Windows

The following provides an overview of the print procedure and features available when printing using 
Windows.

Notes:
• Some options may be unavailable depending on your printer model and configuration.
• Images are representative only.

Print Procedure

Documents can be printed from your computer using the printer drivers supplied. The printer driver 
must be loaded on each PC which uses the machine for printing.

Note: When you select an option in Printing Properties or Preferences, you may see a warning 

mark or . A  mark means you can select that certain option but it is not recommended, 

and a  mark means you cannot select that option due to the machine setting or environment.

1. Select Print in your application.
2. From the Printer: Name drop- down menu, select your machine.
3. Select Properties or Preferences to make your print selections on the individual tabs. For more 

information refer to the following:
• Favorites Tab
• Basic Tab
• Paper Tab
• Graphics Tab
• Advanced Tab
• Earth Smart Tab
• Xerox Tab

4. Select OK to confirm your selections.
5. Select OK to print your document.

Favorites Tab

The Favorites tab lists lists default favorites and user-generated favorites. 

The Favorites option, which is visible on each tab except for the Xerox tab, allows you to save the 
current preferences for future use.

To save a Favorites item, follow these steps:
1. Change the settings as needed on each tab.
2. Click Save.
3. Enter a name and a description, and then select the desired icon.
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Printing Using Windows
4. Click OK. When you save Favorites, all current driver settings are saved.

To use a saved setting, select it in the Favorites tab. The machine is now set to print according to the 
settings you have selected. 

To delete a saved setting, select it in the Favorites tab and click Delete.

Note: Only user-generated favorites can be deleted.

Preview Tab

The Preview tab, in the right panel, is visible only on the Favorites tab. It displays a graphical summary 
of your selections.

Details Tab

The Details tab, in the right panel, is visible only on the Favorites tab. It displays a summary of the 
selected Favorite and notes incompatioable options.

Paper Tab

The Paper tab, in the right panel, is visible on each main tab except for the Favorites and Xerox tabs. It 
displays a graphical summary of your selections.

Device Tab

The Device tab, in the right panel, is visible on each main tab except for the Favorites and Xerox tabs. It 
displays a summary of the device settings.

Printer Status
Note: The Printer Status window and its contents shown in this user guide may differ depending 
on the machine or operating system in use.

The Printer Status option, which is visible on each tab, monitors and informs you of the machine 
status. The Xerox Printer Status dialog includes the following options:

Toner Level

You can view the level of toner remaining in each toner cartridge. The machine and the number of 
toner cartridge(s) shown in the window may differ depending on the machine in use. Some machines 
do not have this feature.

Option

You can set printing job alert related settings.
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Order Supplies

You can order replacement toner cartridge(s) from online.

User’s Guide

This button opens the user guide when an error occurs. You can then open the troubleshooting section 
in the user guide.

Basic Tab

The Basic tab provides selections for the print mode to use and options to adjust how the document 
appears on the printed page. These options include orientation settings, quality settings, layout 
options, and 2-sided printing settings.

Note: Some options may be unavailable depending on your printer model and configuration.

Orientation

Orientation allows you to select the direction in which information is printed on a page.
• Portrait: Prints across the width of the page, letter style.
• Landscape: Prints across the length of the page, spreadsheet style.
• Rotate 180 Degrees: Allows you to rotate the page 180 degrees.

Layout Options

Layout Options allow you to select a different layout for your output. You can select the number of 
pages to print on a single sheet of paper. To print more than one page per sheet, the pages will be 
reduced in size and arranged in the order you specify. 
• Single Page Per Side: Use this option if the layout does not require changing.
• Multiple Pages Per Side: Use this option to print multiple pages on each page. You can print up to 

16 pages on one sheet. Select the number of images required on each side, the page order and if 
borders are required.

• Poster Printing: Use this option to divide a single-page document onto 4, 9 or 16 segments. Each 
segment will be printed on a single sheet of paper for the purpose of pasting the sheets together 
to form one poster-size document. Select Poster 2x2 for 4 pages, Poster 3x3 for 9 pages, or Poster 
4x4 for 16 pages. Then choose the overlap amount in mm or inches.

• Booklet Printing: This allows you to print your document on both sides of the paper and arrange 
the pages so that the paper can be folded in half after printing to produce a booklet. 

Page Border: Use this option to select from a variety of borders for your output.
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2-Sided Printing

You can print on both sides of a sheet of paper. Before printing, decide how you want your document 
oriented.

Note: Some features may not be available on your model.

• Printer Default: If you select this option, this feature is determined by the settings made on the 
control panel of the printer.

• None: The document is printed single-sided.
• Long Edge: This is the conventional layout used in book binding.
• Short Edge: This is the type often used with calendars. 
• Reverse 2-Sided Printing: The document is printed two-sided and the second side images are 

rotated 180 degrees.

Paper Tab

Use the Paper Tab options to set the basic paper handling specifications when you access the printer 
properties.

Copies

This allows you to choose the number of copies to be printed. You can select 1 to 999 copies.

Paper Options
• Original Size: This allows you to set the size of the original you are printing. If the required size is 

not listed in the Size box, select Edit: When the Custom Paper Size Settings window appears, set 
the paper size and select OK. The setting appears in the list so that you can select it.

• Output Size: This allows you to set the size of paper required for printing.
• Percentage: Use this option to change the contents of a page to appear larger or smaller on the 

printed page. Enter the scaling rate in the Percentage input box.
• Source: Use this option to select the paper tray required. Use Manual Feeder when printing on 

special materials like envelopes and transparencies. If the paper source is set to Auto Select, the 
printer automatically selects the paper source based on the requested size.

• Type: Set Type to correspond to the paper loaded in the tray selected. This will provide the best 
quality printout. If printing Envelopes, ensure Envelope is selected.

• Advanced: The advanced paper options allow you to select a different paper source for the first 
page of your document.
• First Page: To have the first page printed on a different paper type from the rest of the 

document select the paper tray containing the paper required.
• Source: Use this option to select the paper tray required. Use Manual Feeder when printing 

on special materials like envelopes and transparencies. If the paper source is set to Auto 
Select: The printer automatically selects the paper source based on the requested size.
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Graphics Tab

Use the following options to adjust the print quality for your specific printing needs.

Quality

This option allows you to select Standard or High Resolution graphics.

Font/Text
• All Text Black: Select this check box to have all text in your document print in solid black, 

regardless of the color it appears on the screen.
• Advanced: Use this option to set font options. True Type fonts can be downloaded as Outline or 

Bitmap Images or printed as Graphics. Select the Use Printer Fonts option if the fonts do not 
require downloading and the printer fonts should be used.

Graphic Controller
• Advanced: Use this option to adjust the brightness and contrast levels.

Toner Saver
• Select On to save toner. 

Advanced Tab

You can select Advanced output options for your document, such as watermarks or overlay text.
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Watermark

This option allows you to print text over an existing document. There are several predefined 
watermarks that come with the printer which can be modified, or you can add new ones to the list.

Using an Existing Watermark

Select the required watermark from the Watermark drop-down list. You will see the selected watermark 
in the preview image.

Creating a Watermark
1. Select Edit from the Watermark drop-down list. The Edit Watermark window appears.
2. Enter a text message in the Watermark Message box. You can enter up to 40 characters. The 

message displays in the preview window. When the First Page Only box is checked, the watermark 
prints on the first page only.

3. Select the watermark options. You can select the font name, style, size, or shade from the Font 
Attributes section and set the angle of the watermark from the Message Angle section.

4. Select Add to add the new watermark to the list.
5. When you have finished editing, select OK.

Editing a Watermark
1. Select Edit from the Watermark drop-down list. The Edit Watermark window appears.
2. Select the watermark you want to edit from the Current Watermarks list and change the 

watermark message options.
3. Select Update to save the changes.
4. When you have finished editing, select OK.

Deleting a Watermark
1. Select Edit from the Watermark drop-down list. The Edit Watermark window appears.
2. Select the watermark you want to delete from the Current Watermarks list and select Delete.
3. Select OK.

Overlay

An overlay is text and/or images stored on the computer hard disk drive as a special file format that 
can be printed on any document. Overlays are often used to take the place of preprinted forms and 
letterhead paper.

Note: This option is only available when you use the PCL6 Printer Driver.

Creating a New Page Overlay

To use a page overlay, you must first create one containing your logo or another image.
1. Create or open a document containing text or an image for use in a new page overlay. Position the 

items exactly as you want them to appear when printed as an overlay.
2. Select Edit from the Overlay drop-down list. The Edit Overlay window appears.
3. Select Create and type a name in the File name box. Select the destination path, if necessary.
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Printing Using Windows
4. Select Save. The name appears in the Overlay List box.
5. Select OK.

Note: The overlay document size must be the same as the documents you print with the overlay. 
Do not create an overlay with a watermark.

6. Select OK on the Advanced tab page.
7. Select OK in the main Print window.
8. An Are you Sure? message displays. Select Yes to confirm.

Using a Page Overlay
1. Select the required overlay from the Overlay drop-down list box.

If the overlay file you want does not appear in the overlay list, select the Edit button and Load 
Overlay, and select the Overlay file.
If you have stored the overlay file you want to use in an external source, you can also load the file 
when you access the Load Overlay window.
After you select the file, select Open. The file appears in the Overlay List box and is available for 
printing. Select the overlay from the Overlay List box.

2. If necessary, select Confirm Page Overlay When Printing. If this box is checked, a message 
window appears each time you submit a document for printing, asking you to confirm your wish to 
print an overlay on your document.
If this box is not checked and an overlay has been selected, the overlay automatically prints with 
your document.

3. Select OK.

Deleting a Page Overlay
1. Select Edit from the Overlay drop-down list. The Edit Overlay window appears.
2. Select the Overlay you want to delete from the Overlay List box.
3. Select Delete Overlay. When a confirming message window appears, select Yes.
4. Select OK.

Output Options

Select the required Print order from the drop-down list box:
• Normal: All pages are printed.
• Reverse All Pages: Your printer prints all pages from the last page to the first page.
• Print Odd Pages: Your printer prints only the odd numbered pages of the document.
• Print Even Pages: Your printer prints only the even numbered pages of the document.

Select the Skip Blank Pages check box if you do not want blank pages to be printed.

To add a binding margin, select the Manual Margin check box and select Details to select the margin 
position and width.
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Printing Using Windows
Earth Smart Tab

The Earth Smart tab provides options to decrease the amount of energy and paper used in the 
printing process and displays a visual representation of the savings made.

Note: This Tab option may be unavailable depending on your machine configuration.

Type

The Type drop-down list is used to select the main Earth Smart option for the printer.
• None: No energy or paper saving options are automatically selected.
• Earth Smart Printing: When this option is selected, 2 Sided Printing, Layout, Skip Blank Pages, 

and Toner Save can be customized to suit requirements.
• Printer Default:This option automatically selects the printer default settings. 

Result Simulator

This area of the Earth Smart Tab shows a visual representation of the estimated energy and paper 
savings based on the selections made.

Enabling Earth Smart Settings with the eco Button

The eco button, on the control panel, maps to Earth Smart settings established in CentreWare Internet 
Services. 

Press the eco button to enable or disable Earth Smart settings.

Default PC Driver Print Settings

The following chart shows the default Earth Smart settings in CentreWare Internet Services:

Printer 2-Sided N-Up Skip Blank Pages Toner Save

3052NI Not available 2Up On On

3260DN Long Edge 2Up On On

3260DNI Long Edge 2Up On On
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Xerox Tab

This tab provides version and copyright information as well as links to drivers and downloads, supplies 
ordering, and the Xerox Web site.
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Xerox Easy Printer Manager (EPM)

Xerox Easy Printer Manager is a Windows-based application that combines Xerox machine settings 
into one location. Xerox Easy Printer Manager conveniently combines device settings as well as 
printing/scanning environments, settings/actions, Scan to PC, and Fax to PC. All of these features 
provide a gateway to conveniently use Xerox devices.

Xerox Easy Printer Manager installs automatically during driver installation.
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Printing Using Macintosh

This section explains how to print using a Macintosh. You need to set the print environment before 
printing. Refer to Installation and Setup.

Printing a Document

When you print with a Macintosh, you need to check the printer driver setting in each application you 
use. Follow the steps below to print from a Macintosh.
1. Open the document you want to print.
2. Open the File menu and select Page Setup (Document Setup in some applications).
3. Choose your paper size, orientation, scale, and other options. Make sure that your machine is 

selected and select OK.
4. Open the File menu and select Print. 
5. Choose the number of copies you want and indicate which pages you want to print. 
6. Select Print.

Changing Printer Settings

You can use advanced printing features provided by your machine.

Open an application and select Print from the File menu. The machine name which appears in the 
printer properties window may differ depending on the machine in use. Except for the name, the 
composition of the printer properties window is similar to the following.

Note: The setting options may differ depending on the printer and the Macintosh OS version.

TextEdit

This option allows you to print a header and footer.

Print Features

Set Media Type to correspond to the paper loaded in the tray from which you want to print. This will 
let you get the best quality printout. If you load a different type of print material, select the 
corresponding paper type.
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Layout

The Layout option provides options to adjust how the document appears on the printed page. You can 
print multiple pages on one sheet of paper.

Two-Sided: Allows you to print a double -side document.

Reverse page orientation: Allows you to reverse the page orientation (rotate 180 degrees). For 
example, to print the top of a document on the left edge of the paper, select landscape orientation 
and select Reverse Page Orientation.

Paper Handling

This option allows you to to set these basic paper handling specifications: Collate Pages, Pages to 
Print, Page Order, Scale to fit paper size.

Cover Page

This option allows you to print a cover page before or after the document. 

Supply Levels

This option shows the current toner level.

Graphics

This option allows you to select the printing resolution. The higher the setting, the sharper the clarity of 
printed characters and graphics. The higher setting also may increase the time it takes to print a 
document.

Printing Multiple Pages on One Sheet

You can print more than one page on a single sheet of paper. This feature provides a cost-effective way 
to print draft pages.
1. Open an application, and select Print from the File menu.
2. Select Layout from the drop-down list under Pages. In the Pages per Sheet drop-down list, select 

the number of pages you want to print on one sheet of paper.
3. Select the other options you want to use.
4. Select Print. The machine prints the selected number of pages you want to print on one sheet of 

paper.
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Two Sided Printing

You can print on both sides of the paper.
1. From your Macintosh application, select Print from the File menu.
2. Select Layout from the drop-down list under Orientation. 
3. Select On from the Two Sided Printing option.
4. Select the other options you want to use and select Print.

Using AirPrint

AirPrint is a software feature that allows for driverless printing from Apple iOS-based mobile 
devicesand Macintosh OS-based devices. AirPrint-enabled printers let you print directly from a 
Macintosh or from an iPhone, iPad, or iPod touch. For more information, refer to the topic AirPrint in 
Installation and Setup in this user guide.

Using Google Cloud Print

Google Cloud Print is a service that allows you to print to a printer using your smart phone, tablet, or 
any other web-connected devices. For more information, refer to the topic Google Cloud Print in 
Installation and Setup in this user guide.
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Printing Using Linux

Printing from Applications

There are a lot of Linux applications that allow you to print using Common Unix Printing System 
(CUPS). You can print on your machine from any such application.
1. Open an application, and select Print from the File menu.
2. Select Print directly using lpr.
3. In the LPR GUI window, select the machine from the printer list and select Properties.
4. Change the print job properties using the following four tabs displayed at the top of the window.

• General: This option allows you to change the paper size, the paper type, and the orientation 
of the documents. It enables the duplex feature, adds start and end banners, and changes 
the number of pages per sheet.

• Text: This option allows you to specify the page margins and set the text options, such as 
spacing or columns.

• Graphics: This option allows you to set image options that are used when printing image 
files, such as color options, image size, or image position.

• Advanced: This option allows you to set the print resolution, paper source, and destination.
5. Select Apply to apply the changes and close the Properties window.
6. Select OK in the LPR GUI window to start printing.

The Printing window appears, allowing you to monitor the status of your print job.

Printing Files

You can print many different file types on your machine using the standard CUPS utility, directly from 
the command line interface. However, the drivers package replaces the standard lpr tool with a much 
more user-friendly LPR GUI program.

To print any document file:
1. Type lpr <file_name> from the Linux shell command line and press Enter. The LPR GUI window 

appears.
2. When you type only lpr and press Enter, the Select file(s) to print window appears first. Select 

any files you want to print and select Open.
3. In the LPR GUI window, select your machine from the list, and change the print job properties.
4. Select OK to start printing.

Configuring Printer Properties

Using the Printer Properties window provided by the Printers configuration, you can change the various 
properties for your machine as a printer.
1. Open the Unified Driver Configurator.

If necessary, switch to Printers configuration.
2. Select your machine on the available printers list and select Properties.
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Printing Using Linux
3. The Printer Properties window opens.
The following five tabs display at the top of the window:
• General: This option allows you to change the printer location and name. The name entered 

in this tab displays on the printer list in Printers configuration.
• Connection: This option allows you to view or select another port. If you change the machine 

port from USB to parallel or vice versa while in use, you must re-configure the machine port in 
this tab.

• Driver: This option allows you to view or select another machine driver. Selecting Options you 
to set the default device options.

• Jobs: This option shows the list of Print jobs. Select Cancel job to cancel the selected job and 
select the Show completed jobs check box to see previous jobs on the job list.

• Classes: This option shows the class that your machine is in. Select Add to Class to add your 
machine to a specific class or select Remove from Class to remove the machine from the 
selected class.

4. Select OK to apply the changes and close the Printer Properties window.
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Printing Using Unix

Printing Files 

After installing the printer, choose any of the images, text, PS to print.
1. Execute “printui <file_name_to_print>” command. For example, if you are printing “document1” 

use printui document1 command.
This will open the Unix printer driver Print Job Manager in which the user can select various print 
options.

2. Select a printer that has already been added.
3. Select the printing options from the window such as Page Selection.
4. Select how many copies are needed in Number of Copies.
5. Press OK to start the print job.

Configuring Printer Properties

The Unix printer driver Print Job Manager allows you to configure various print options using the 
printer Properties option. The following hot keys may also be used: H for Help, O for OK, A for Apply, 
and C for Cancel.

General Tab
• Paper Size: Set the paper size as A4, Letter, or other paper sizes, according to your requirements.
• Paper Type: Choose the type of the paper. Options available in the list box are Printer Default, 

Plain, and Thick.
• Paper Source: Select from which tray the paper is used. By default, it is Auto Selection.
• Orientation: Select the direction in which information is printed on a page.
• Duplex: Print on both sides of paper to save paper.
• Multiple pages: Print several pages on one side of the paper.
• Page Border: Choose any of the border styles (e.g., Single-line hairline, Double-line hairline)

Image Tab

In this tab, you can change the brightness, resolution, or image position of your document.

Text Tab

Use this tab to set the character margin, line space, or the columns of the actual print output.
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Margins Tab
• Use Margins: Set the margins for the document. By default, margins are not enabled. The user 

can change the margin settings by changing the values in the respective fields. Set by default, 
these values depend on the page size selected.

• Unit: Change the units to points, inches, or centimeters.

Printer-Specific Settings Tab

Select various options in the JCL and General frames to customize various settings. These options are 
specific to the printer and depend on the PPD file.
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5Security

This chapter describes how to configure the Security features for the machine.

The following topics are mentioned in this chapter:
• Security at Xerox 
• Security Settings
• Machine Digital Certificate Management
• SNMP
• SNMPv3
• IP Sec
• IP Filtering
• 802.1X Authentication
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Security at Xerox

For the latest information on securely installing, setting up and operating your machine see the Xerox 
Security Information Web site located at www.xerox.com/security.

Security Settings

To prevent unauthorized changes to printer settings, ensure a login ID and password are entered in the 
System Administrator area. 

Administrator Accounts
1. At your workstation, open the Web browser and enter the IP Address of the machine in the 

Address Bar.
2. Press Enter.
3. Select Properties.
4. If prompted, enter the Administrator User Name (admin) and Password (1111), and select Login. 

Click Properties.
5. In the Security link on the left hand side select the System Security link.
6. Select System Administrator.
7. If required, enter Administrator details for:

• Name
• Phone Number
• Location 
• E-mail Address 

8. The WebUI Access Control check box controls access to the Internet Services screen. Select 
Enable, if required.

9. To change the Administrator Password, select the Change Password box and enter the required 
Login ID and Password. The default is admin and 1111, respectively.

10. Select the Advanced button for Advanced Access Control. 
11. Select Protect Login IPv4 Address if required, and enter the required login IP address that you 

want to protect in the IPv4 Address box.
12. Select the required option for Login Failure Policy. The options are: Off, 3 times and 5 times.
13. Select the required number of minutes from the Auto Logout menu. 
14. Select Security Settings Reset to enable this option if required.
15. Select Save.
16. Select Apply to save the changes.
17. Select OK when the acknowledgement message displays.
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Feature Management

The Feature Management screen allows you to control the Services, Physical Ports, PC Scan Security 
and Network Protocols that are available on the machine.
1. At your workstation, open the Web browser and enter the IP Address of the machine in the 

Address Bar.
2. Press Enter.
3. Select Properties.
4. If prompted, enter the Administrator User Name (admin) and Password (1111), and select Login. 

Click Properties.
5. In the Security link on the left hand side select the System Security link.
6. Select the Feature Management link in the directory tree. 
7. To enable or disable a feature, select the required Enable box or Disable link. 

• For the LPR/LPD Protocol, enter the required port number. (The default is 515.)
• For Raw TCP/IP Printing Protocol, enter the required port number (The default is 9100).

8. Click Apply to save the changes.
9. Select OK.

Restart Device

The Restart Device screen allows you to reboot the machine remotely from your desktop.

Note: When the machine is restarted, the Network Controller will take some time to restart.
The network connectivity will be unavailable during this time.

1. At your workstation, open the Web browser and enter the IP Address of the machine in the 
Address Bar.

2. Press Enter.
3. Select Properties.
4. If prompted, enter the Administrator User Name (admin) and Password (1111), and select Login. 

Select Properties.
5. In the Security link on the left hand side, select the System Security link.
6. Select the Restart Device link in the directory tree. 
7. To reboot the machine, select the required Restart Now button.
8. The Do you really want to restart the device screen appears. Click Yes. The machine reboots. 

CentreWare Internet Services may be unavailable for several minutes while the machine reboots.
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Machine Digital Certificate Management

The following topics are covered in this section:
• Overview
• Information Checklist
• Access the Machine Digital Certificate Management Screen
• Create a Self Signed Certificate
• Install a CA Signed Device Certificate
• Enable Secure Connection

Overview

The machine can be configured for secure access with the SSL (Secure Socket Layer) protocol via 
Digital Certificates. SSL enables secure access to the machine.

To enable SSL on a machine, it needs to have its own digital certificate. When clients make a request to 
the machine, it exports the certificate to provide an encrypted channel.

There are two options available to obtain a server certificate for the machine:
• Have the machine create a Self Signed Certificate
• Create a request to have a Certificate Authority sign a certificate that can be uploaded to the 

machine.

A self-signed certificate means that the machine signs its own certificate as trusted and creates the 
public key for the certificate to be used in SSL encryption.

A certificate from a Certificate Authority or a server functioning as a Certificate Authority (for example 
Windows 2000 running Certificate Services) can be uploaded to the machine. 

Note: A separate request is required for each Xerox machine.

Information Checklist

Ensure that the machine is configured with the following items:
• An IP Address or Host Name must be configured on the machine.
• DNS must be enabled and configured on the machine.

Note: This is used to set the start time for self signed certificates.

Access the Machine Digital Certificate Management Screen
1. At your workstation, open the Web browser and enter the IP Address of the machine in the 

Address Bar.
2. Press Enter.
3. Select the Properties icon.
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Machine Digital Certificate Management
4. If prompted, enter the Administrator User Name (admin) and Password (1111), and select Login. 
Select Properties.

5. In the Security link on the left hand side select the Network Security link.
6. Select the Digital Certificate link. The Certificate Management page displays.
7. Select Add. 

Select one of the following options:
• Install/Create Device Certificate or CSR. The following options are available:

• Create a Self Signed Device Certificate
• Install CA signed Device Certificate
• Create Certificate Signing Request (CSR)

• Install Root Certificate 

Create a Self Signed Certificate
1. In the Install/Create New Certificate area select Create a Self Signed Device Certificate.
2. Select Next.
3. In the Self Signed Certificate area:

a. Enter a Friendly Name.
b. In the 2 Letter Country Code field enter the Country Code that represents the country in 

which the machine is located. The country code must be entered as a two-character ISO 3166 
country code.

c. If required, enter details in the following fields:
• State/Province Name
• Locality Name
• Organization Name
• Organization Unit

Information entered for these options should describe the machine as per the X500 directory 
scheme but can be any value which is meaningful to the customer to identify the machine.

Note: The Common Name is taken from the machine’s IP Address/Host Name and Domain 
Name. 

d. In the Valid Period box, enter the number of days that the certificate should be valid. Once 
the specified time is reached, the certificate will expire. The start time is based on the current 
machine system time so it is important that the time is set correctly on the machine. 

e. Enter the E-mail Address of the Administrator who is responsible for the secure management 
of the machine.

4. Select the Next button. A message displays to show the success of the certificate creation. 
5. Click the Close button. The certificate displays in the Certificate Management area. 
6. Follow the steps in Enable Secure Connection.
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Create a Certificate Signing Request
1. In the Install/Create New Certificate area select Create Certificate Signing Request.
2. Select Next.
3. In the Certificate Signing Request (CSR) area:

a. Enter a Friendly Name to identify the request.
b. In the 2 Letter Country Code field enter the Country Code that represents the country in 

which the machine is located. The country code must be entered as a two-character ISO 3166 
country code.

c. If required, enter details in the following fields:
• State/Province Name
• Locality Name
• Organization Name
• Organization Unit

Information entered for these options should describe the machine as per the X500 directory 
scheme but can be any value which is meaningful to the customer to identify the machine.

Note: The Common Name is taken from the machine’s IP Address/Host Name and Domain 
Name. 

d. Enter the E-mail Address of the Administrator who is responsible for the secure management 
of the machine.

4. Click Next.
5. In the Certificate Signing Request (CSR) area, click Download.
6. Send the downloaded file to your Certificate Authority for digital signing.
7. When you receive the signed certificate back from the Certificate Authority, follow the steps below 

to Install a CA Signed Device Certificate. 

Install a CA Signed Device Certificate
1. In the Install/Create New Certificate area, select Install CA Signed Device Certificate.
2. Select Next.
3. In the Certificate Information area:

a. Enter a Friendly Name to identify the certificate
b. Enter the required Private Password and Confirm Password.
c. In the CA Signed Certificate area click Browse to find the certificate file on your computer. 

Select the file.
d. Click Next.

4. Select the Apply button to accept the changes.
If prompted, enter the Administrator User Name (admin) and Password (1111), and select OK.

5. If successful, the Current Status area displays a confirmation message.
6. Follow the steps in Enable Secure Connection.
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Install Root Certificate
1. In the Install Root Certificate area select Install new Root Certificate.
2. Select Next.
3. In the Certificate Information area, enter a Friendly Name to identify the certificate.
4. In the Root Certificate area click Browse to find the certificate file on your computer. Select the 

file.
5. Click Next.
6. Select the Apply button to accept the changes.

If prompted, enter the Administrator User Name (admin) and Password (1111), and select Login.
7. If successful, the Current Status area will display a confirmation message.
8. Follow the steps in Enable Secure Connection.

Enable Secure Connection

Once the machine has a machine Server Certificate, you can enable Secure Connection.
1. At your workstation, open the Web browser and enter the IP Address of the machine in the 

Address Bar.
2. Press Enter.
3. Select the Properties icon.
4. If prompted, enter the Administrator User Name (admin) and Password (1111), and select Login. 

Select Properties.
5. In the Security link on the left hand side, select the Network Security link.
6. Select the Secure Connection link.
7. Click the Select Certificate button and select the required certificate. Click Select. The certificate 

displays in the Certificate for Secure Connection area.
8. In the Secure HTTP area, select the required option in the HTTPs menu. Select Both HTTP and 

HTTPs to enable Secure IPP or select HTTPs Only.
9. Select Import and Export Functions if required.
10. If you selected Both HTTP and HTTPs, select On from the IPPs menu if required.
11. Select Apply to save the changes.
Xerox® Phaser® 3052/3260
User Guide

105

Download from Www.Somanuals.com. All Manuals Search And Download.



Machine Digital Certificate Management
Edit or Delete a Certificate
1. At your workstation, open the Web browser and enter the IP Address of the machine in the 

Address Bar.
2. Press Enter.
3. Select the Properties icon.
4. If prompted, enter the Administrator User Name (admin) and Password (1111), and select Login. 

Click Properties.
5. In the Security link on the left hand side, select the Network Security link.
6. Select the Digital Certificate link. The Certificate Management page displays with a list of the 

certificates installed on this machine.
7. Select the check box next to the Friendly Name of the certificate that you want to edit or delete. 

• Select the Edit button to edit the certificate. Make the required changes and click Apply.
• Select the Delete button to delete the certificate, and click Yes to confirm.
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SNMP

SNMP (Simple Network Management Protocol) settings can be configured via CentreWare Internet 
Services. 
1. At your workstation, open the Web browser and enter the IP Address of the machine in the 

Address Bar.
2. Press Enter.
3. Select the Properties icon.
4. If prompted, enter the Administrator User Name (admin) and Password (1111), and select Login. 

Select Properties.
5. In the Network Settings link select the SNMP link.
6. Select SNMPv1/v2.

a. Select the Enable check box to enable SNMPv1/v2 Protocol.
b. Select the required Community Name from the list, or click Add to add a new SNMP 

Community. The Add pop-up menu appears.
• Enter the required Name for the SNMP Community.
• Select the required Access Permission.

7. Select Apply to save the changes.
8. Select OK when the acknowledgement message displays.

SNMP Traps

You can specify IPv4 Trap Destination Addresses.
1. From the SNMP page, in the SNMP Traps area select Add.
2. In the Trap Destination Address area, enter details in the IPv4 Address and Port Number fields.
3. In the Traps area, enter the name in the TRAP Community Name field.
4. For Traps to be received select the apropriate check boxes for the following Traps:

• Printer Traps
• Cold Start Traps
• Warm Start Traps

5. Select Apply to save the changes.
6. Select OK when the acknowledgement message displays.

To Edit Community Names or SNMP Traps
1. From the SNMP page, in the Community Names or SNMP Traps area select the name or address 

you want to edit.
2. Select Edit.
3. Change the required options and select Apply to save the changes.
4. Select OK.
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To Delete Community Names or SNMP Traps
1. From the SNMP page, in the Community Names or SNMP Traps area select the name or address 

you want to delete.
2. Select Delete.
3. Select Yes.

Note: Changes made to the GET or SET community names for this machine will require 
corresponding GET or SET community name changes for each application which uses the SNMP 
protocol to communicate with this machine (e.g., Xerox CentreWare Web, any third party network 
management applications, etc.).
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SNMPv3

SNMPv3 can be enabled to create an encrypted channel for secure machine management.
1. At your workstation, open the Web browser and enter the IP Address of the machine in the 

Address Bar.
2. Press Enter.
3. Select the Properties icon.
4. If prompted, enter the Administrator User Name (admin) and Password (1111), and select Login. 

Click Properties.
5. In the Network Settings link select the SNMP link.
6. Select the SNMPv3 link. The SNMPv3 page displays.
7. In the Setup area:

a. Select the Enable check box to enable SNMPv3 Protocol.
b. In the Authentication area, enter the required User Name.
c. Enter a password in the Authentication Password field.
d. Enter the password again in the Confirm Password field.
e. For Authentication Algorithm, select either MD5 or SHA. 
f. Enter a password in the Privacy Password field.
g. Enter the password in the Confirm Password field.
h. The Privacy Algorithm displays.

8. Select Apply to save the changes.
9. Select OK when the acknowledgement message displays.
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IP Sec

IP Sec (IP Security) is comprised of the IP Authentication Header and IP Encapsulating Security 
Payload protocols, that secure IP communications at the network layer of the protocol stack, using 
both authentication and data encryption techniques. The ability to send IP Sec encrypted data to the 
printer is provided by the use of a public cryptographic key, following a network negotiating session 
between the initiator (client workstation) and the responder (printer or server). To send encrypted data 
to the printer, the workstation and the printer have to establish a Security Association with each other 
by verifying a matching password (shared secret) to each other. If this authentication is successful, a 
session public key will be used to send IP Sec encrypted data over the TCP/IP network to the printer. 
Providing additional security in the negotiating process, SSL (Secure Sockets Layer protocols) are used 
to assure the identities of the communicating parties with digital signatures (individualized checksums 
verifying data integrity), precluding password guessing by network sniffers.

Enable IP Sec

This procedure requires that you have a Shared Secret available.

IP Sec cannot be enabled until Secure Connection is enabled on the machine. For instructions, refer to 
Enable Secure Connection.
1. At your workstation, open the Web browser and enter the IP Address of the machine in the 

Address Bar.
2. Press Enter.
3. Select the Properties icon.
4. If prompted, enter the Administrator User Name (admin) and Password (1111), and select Login. 

Select Properties.
5. In the Security link on the left hand side, select the Network Security link.
6. Select the IP Security link. The IP Security page displays.
7. Click Enable to enable the IP Sec protocol.
8. Enter the Shared Secret and Confirm Shared Secret.
9. Select Apply to save the settings. Select OK when the acknowledgement message displays.
10. The IP Sec Current Status confirms the status of the IP Sec protocol.
11. To change the Shared Secret, click the Change Shared Secret button and enter the new Shared 

Secret information. 
12. Click Apply to save the changes.
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IP Filtering

Overview

The IP Filtering is a security feature that allows you to control access to Internet Services. IP Filtering 
allows you to prevent unauthorized access by IP (Internet Protocol).

The IP Filtering feature provides security to the machine, by allowing you to register the IP addresses 
permitted to communicate with the machine. This feature is used to prevent Raw TCP/IP Printing, 
LPR/LPD, HTTP, Fax to PC, IPP, SNMP and Scan Manager for Network from unauthorized users

Enable IP Filtering
1. At your workstation, open the Web browser, and enter the IP Address of the machine into the 

Address bar. 
2. Press Enter.
3. Click the Properties icon.
4. If prompted, enter the Administrator User ID admin and Password 1111, and click on Login.
5. Click the Security link.
6. Click the Network Security link.

For IPv4 Filtering
1. Select IPv4 Filtering.
2. Select the IPv4 Filtering Enable check box.
3. Enter the IP Address(es) to permit IP addresses to access the device.
4. Enter the IP address or an IP address range by using an asterisk (*) as a wild-card character. For 

example:
192.246.238.* is used to reference a subnet of host addresses
192.246.* is used to reference a wider subnet of host addresses
192.* is used to reference the widest subnet of host addresses

5. The ability to filter on a port or ports is also supported. Enter the port information.
6. Click Apply to accept changes.
7. Click OK.

For IPv6 Filtering
1. Select IPv6 Filtering.
2. Select the IPv6 Filtering Enable check box.
3. Enter the IP Address(es) to permit IP addresses to access the device.
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IP Filtering
4. Enter the IPv6 address in the form of a CIDR convention. Prefix indicates the number of leftmost 
bits to be referenced.
For example:
2001:DB8:1234:215:215:99FF:FE04:D345 / 128 is used to reference a complete address. 
2001:DB8:1234:215:215:99FF:FE04:D345 / 64 is used to reference prefix address consisted of 
leftmost 64 bits only. 
2001:DB8:1234:215:215:99FF: / 80 is used to reference prefix address consisted of leftmost 80 
bits only.

5. The ability to filter on a port or ports is also supported. Enter the port information.
6. Click Apply to accept changes.
7. Select OK when the acknowledgement message displays.

Enable MAC Filtering
1. Select MAC Filtering in the directory tree. The MAC Filtering page displays.
2. Select the MAC Filtering Enable check box.
3. In the MAC Address to Filter Out area, select Add.
4. Enter the MAC Address that you want to filter out.
5. Select Apply to save the changes.
6. Select OK when the acknowledgement message displays.
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802.1X Authentication

This is the procedure to follow to install and setup 802.1X Authentication:

Overview

The Xerox machine supports IEEE 802.1X Authentication via Extensible Authentication Protocol (EAP). 
IEEE 802.1X ensures all machines on the network are authenticated and authorized to use the 
network. 802.1X can be enabled for machines connected through wired Ethernet networks.

The Administrator can configure the machine to use one EAP type. EAP types supported on the 
machine are:
• EAP-MD5
• PEAP
• EAP-MSCHAPv2
• EAP-TLS

Information Checklist

Before starting, ensure that the following items are available and/or the tasks have been performed:
• 802.1X authentication must be supported on the network where the machine is connected.
• Ensure that your 802.1X Authentication Server and authentication switch are available on the 

network.
• Create a User Name and Password on your Authentication Server that will be used to authenticate 

the machine.

Enable 802.1X using CentreWare Internet Services

Authentication via TLS requires a Device Certificate to be configured or uploaded to the machine. For 
instructions, refer to Access the Machine Digital Certificate Management Screen.

Authentication via PEAP and TLS require a Root Certificate to be uploaded to the machine. For 
instructions refer to Install Root Certificate.
1. At your workstation, open the Web browser and enter the IP Address of the machine in the 

Address Bar.
2. Press Enter.
3. Select the Properties icon.
4. If prompted, enter the Administrator User Name (admin) and Password (1111), and select Login. 

Click Properties.
5. In the Security link on the left hand side select the Network Security link.
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802.1X Authentication
6. Select 802.1X in the directory tree. The 802.1x Security page displays.
a. For 802.1x Security, select the Enable check box to enable.
b. From the Authentication Methods area select one of the following methods:

• EAP-MD5
• EAP-MSCHAPv2
• PEAP
• TLS

7. If you select EAP-MD5, EAP-MSCHAPv2 or PEAP, the Credentials option appears. Enter the 
required details in the Username and Password fields.

8. If you select PEAP or TLS, the Server Validation option appears. Click the Select Certificate 
button and select the required root certificate to provide server validation.

9. If you select TLS, the Device Validation option appears. Click the Select Certificate button and 
select the required certificate to provide device validation.

10. Select the Apply button to accept the changes. 
11. Select OK when the acknowledgement message displays.
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6Maintenance

This chapter includes:
• Consumables
• General Care 
• Software Update 
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Consumables
Consumables

Customer-replaceable consumable supplies for this printer include the following:
• Xerox Phaser 3052 / 3260 Standard Capacity Toner Cartridge
• Xerox Phaser 3052 / 3260 High Capacity Toner Cartridge
• Xerox Phaser 3052 / 3260 Standard Capacity Drum Cartridge 

Placing an Order for Xerox Consumables:

Xerox supplies for your printer can be ordered in several ways:
• Contact your local Xerox Representative or reseller. Provide your Company Name, product number 

and the machine serial number. 

Note: The machine’s serial number is located on the machine’s data plate on the rear cover, is 
accessible from the Machine Status button in the System Setup menu, and also is printed on the 
Configuration report. 

• Order supplies online at www.xerox.com
• Access the Xerox Web page via Easy Printer Manager:
1. Select the printer for which you want to order supplies. 
2. Click the Order Supplies button. 
3. When another window pops up, select Order Supplies. When the Xerox Web page for ordering 

supplies appears, place your order. 
• Access the Xerox Web page via CentreWare: From your printer’s CWIS page, click the Support tab, 

then Support Links on the left navigation panel. Then click the Order Supplies link on the bottom 
of the page to go to the Xerox Web site and order online. 

WARNING: Use of non-Xerox supplies is not recommended. Use of toner and drum cartridges 
other than those using genuine Xerox Toner can affect print quality and printer reliability. Xerox 
Toner is the only toner designed and manufactured under strict quality controls by Xerox for use 
with this specific printer.

The Xerox Warranty, Service Agreement, and Total Satisfaction Guarantee do not cover damage, 
malfunction, or degradation of performance caused by use of non-Xerox supplies, or the use of 
Xerox supplies not specified for this printer. The Total Satisfaction Guarantee is available in the 
United States and Canada. Coverage could vary outside these areas. Contact your Xerox 
representative for details.
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Consumables
Checking the Status of Consumables

You can check the status of your installed printer consumables at any time in several ways.

From the Printer

If you enabled the Low Toner Indicator (usually during setup of your printer) an 
orange LED symbol at the top of the control panel indicates the status of the toner 
level in the toner cartridge.
• When that symbol light is off (as shown), the toner cartridge still has normal capacity.
• When that symbol is blinking orange, a small amount of toner is left in the cartridge. The cartridge 

is close to its estimated limit of use. Check that a new Xerox replacement toner cartridge is 
available and order one if not. You may temporarily increase the printing quality by redistributing 
toner; see Redistributing Toner. 

• When that toner LED symbol is solid orange, it is time to replace the cartridge. See Replacing the 
Toner Cartridge. 

To enable the Low Toner Indicator: 
1. At your PC, open Easy Printer Manager from the Start menu (in Windows).
2. Select the printer.
3. Click Properties. You will be taken to the CentreWare Internet Services page for the printer. 
4. If prompted, enter the ID (admin) and Password (1111).
5. Select Properties > System > Setup.
6. Set the Low Toner Alert to On.
7. Enter a percentage for the Toner Low Alert Level from 1 - 50%.
8. Select Apply. Users will now be alerted by the orange blinking/solid Toner LED on the control panel 

when the toner cartridge is low on toner or out of toner.
9. Next set the Low Image Unit Alert to On. 
10. Select the additional Alert features you wish to enable. E-mail Alert will send you an e-mail when 

the printer is low on toner or needs a new toner cartridge. See the Alerts information in 
Installation and Setup.

11. Select Apply. Users will now be alerted in several ways when the printer needs supplies attention. 

Checking Supplies Status from Your PC

Use Easy Printer Manager (EPM) to view a supplies status page:
1. At your PC, open Easy Printer Manager from the Start menu (in Windows). 
2. Select the printer.
3. From the Basic mode page (the smaller window), you can see the supply levels in the Supplies tab. 

If you open EPM in the Advanced mode (large window) you will see Supplies Information just 
below the device picture.

Note: Use the Switch icon in the EPM header to move between Basic and Advanced modes. 
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Consumables
Use CentreWare Information Services (CWIS) to check supplies status. 

Note: You must have the printer connected to the network to access CWIS. It will not be available 
via a USB connection.

1. Enter the IP Address of the printer in your Internet browser.
2. If prompted from the CentreWare page, enter the ID (admin) and Password (1111).
3. Select the Status tab. 
4. Click Supplies in the left navigation to see the toner levels and imaging unit levels in the printer. 

Storage and Handling of Consumables

The toner and drum cartridges contain components that are sensitive to light, temperature, and 
humidity. Follow the recommendations provided to ensure the optimum performance, highest quality, 
and longest life from your new cartridge.

Follow the guidelines below for storing and handling consumables:
• Always store consumables unopened and inside their original package. 
• Store the correct side up in a horizontal position (not standing on end).
• Do not store consumables in:

• Temperatures greater than 40°C (104°F).
• Humidity range less than 20% and not greater than 80%.
• An environment with extreme changes in humidity or temperature.
• Direct sunlight or room light.
• Dusty places.
• A vehicle for a long period of time.
• An environment where corrosive gases are present.
• An environment with salty air.

• Do not store consumables directly on the floor.
• Do not touch the surface of the photosensitive drum in the cartridge.
• Do not expose the cartridges to unnecessary vibrations or shock.
• Never manually rotate the drum in the cartridge, especially in the reverse direction; this can cause 

internal damage and toner spillage.
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General Care

Redistributing Toner

When the toner cartridge is near the end of its life:
• White streaks on prints or light printing occurs. 
• The toner LED light at the top of the control panel is blinking orange if the Low Toner Alert feature 

has been enabled.

If either of these conditions occurs, you can temporarily improve print quality by redistributing the 
remaining toner in the cartridge. In some cases, white streaks or light printing will still occur even after 
you have redistributed the toner.

Follow these steps to redistribute the toner in your cartridge and thus temporarily improve print quality.
1. Open the front cover of the printer.

2. Pull out the cartridge using the handle with the colored 
label. 

3. Slowly shake the cartridge five or six times to distribute 
the toner evenly inside the cartridge. 

Note: If toner gets on your clothing, wipe it off with a dry 
cloth and wash clothing in cold water. Hot water sets 
toner into fabric.
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General Care
4. Insert the toner cartridge slowly into the printer, 
pushing it until it locks into place. 

5. Close the front cover of the printer. The Machine 
Status light should be solid green, indicating the 
printer is ready to print.

Replacing the Toner Cartridge

When the Toner LED light on the control panel is solid orange, it is time to replace the toner cartridge. 
To replace the cartridge, follow the instructions provided below or with the consumable.

WARNING: When replacing consumables, DO NOT remove the covers or guards that are fastened 
with screws. You cannot maintain or service any of the parts that are behind these covers and 
guards. Do NOT attempt any maintenance procedure that is NOT specifically described in the 
documentation supplied with your machine.

1. Open the front cover of the printer.

2. Pull the toner cartridge out using the handle.
3. Remove the new toner cartridge from the packaging. 

Follow the packaging directions to remove the 
protective packaging materials from the cartridge. 
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4. Slowly shake the new cartridge five or six times to 
distribute the toner evenly inside the cartridge. 

Note: If toner gets on your clothing, wipe it off with a 
dry cloth and wash clothing in cold water. Hot water 
sets toner into fabric. 

5. Hold the toner cartridge by the handle and slowly 
insert the cartridge into the opening in the machine. 
Tabs on the sides of the cartridge and corresponding 
grooves within the machine will guide the cartridge 
into the correct position until it locks into place.

6. Close the front cover. The Machine Status light will 
return to green, indicating the printer is ready. The 
Toner LED light should not be lit, indicating there is 
enough toner to print. 

Replacing the Drum Cartridge 

When it is time for a new drum cartridge, the Machine Status light on the control panel blinks red. To 
replace the Drum Cartridge, follow the instructions provided below or with the consumable.

1. Open the front cover.
2. Pull the toner cartridge out and place it on a clean flat 

surface.
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General Care
3. Pull the drum cartridge out slowly by the handle. 
4. Remove the new drum cartridge from the packaging. 

Use the handle on the cartridge to avoid touching 
sensitive parts that can be easily damaged. 

CAUTION: Do not touch the green underside of the 
drum cartridge. Use the handle on the cartridge to 
avoid touching this area. 

5. Hold the new drum cartridge by the handle and 
insert it into the machine until it locks into place. 

6. Re-install the toner cartridge. 
7. Close the machine front cover. When the Machine 

Status light is solid green, the machine is ready.

Recycling Consumables

For information on Xerox supplies recycling programs, go to www.xerox.com/gwa.
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Cleaning the Machine

WARNING: When cleaning the machine do NOT use organic or strong chemical solvents or 
aerosol cleaners. Do NOT pour fluids directly onto any area. Use supplies and cleaning materials 
only as directed in this documentation. Keep all cleaning materials out of the reach of children.

WARNING:  Do not use pressurized air-spray cleaning aids on or in this equipment. Some 
pressurized air-spray containers contain explosive mixtures and are not suitable for use in 
electrical applications. Use of such cleaners can result in a risk of explosion and fire.

Control Panel, Paper Tray and Output Tray

Regular cleaning keeps the display, control panel and other external machine areas free from dust and 
dirt. 
1. Use a soft, lint-free cloth, lightly dampened with water.
2. Wipe clean the entire area of the control panel.
3. Wipe clean the output tray and other outside areas of your machine.
4. Remove any residue with a clean cloth or paper towel.

Internal Areas

During the printing process, paper, toner, and dust particles can accumulate inside the machine. This 
can cause print quality problems, such as toner specks or smearing. Cleaning inside the machine clears 
and reduces these problems.
1. Turn the machine off and unplug the power cord. Wait for the machine to cool down.
2. Open the front cover.
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General Care
3. Remove the cartridges: 1: Pull out the toner cartridge and 
place it on a clean flat surface. 2: Remove the drum 
cartridge using the handle and place it on a clean flat 
surface.

CAUTION:

• To prevent damage to the drum cartridge, do not 
expose it to light for more than a few minutes. Cover 
it with a piece of paper, if necessary. 

4. With a dry, lint-free cloth, wipe away any dust and spilled 
toner from the cartridge area.

CAUTION: While cleaning the inside of the machine, be 
careful not to damage any inside parts. Do not use 
solvents such as benzene or thinner to clean. Printing 
quality problems can occur and damage can be caused 
to the machine.

5. Re-install the drum cartridge. Then re-install the toner cartridge. Tabs on the sides of the cartridges 
and corresponding grooves within the machine will guide each cartridge into the correct position 
until it locks into place. 

6. Close the front cover.
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7. Plug in the power cord and turn the machine on. When 
the Machine Status light is solid green, the printer is 
ready to print. 

Moving the Machine
• When moving the machine, do not tilt or turn it upside down as the inside of the machine may 

become contaminated with toner, which can cause damage to the machine or adversely affect 
print quality.

• When moving the machine, make sure to hold the machine securely from the bottom. 
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Software Update

Xerox is continually seeking to improve its products. A software revision may become available to 
improve the functionality of your machine. The Software Upgrade feature allows the customer to 
upgrade the machine software without needing a Customer Service Representative to be present.

The Software Upgrade Process

The software can be upgraded over a network connection using CentreWare Internet Services. 
• Any jobs in the queue must be allowed to complete or be deleted before initiating a software 

upgrade. 
• This procedure will prevent further jobs from being received until the upgrade has completed. 
• All configured network settings and installed options will be retained by the machine after the 

Software Upgrade process. 

Process Checklist

Before starting, ensure that the following items are available and/or the tasks have been performed:
• Obtain the new software upgrade file for your machine from the www.xerox.com Web site or from 

your Xerox Customer Support Representative. The upgrade file will have an extension of .hd. 
Download the upgrade file to a local or network drive. You will be able to delete the file after the 
upgrade procedure.

• It is important to obtain the correct upgrade file for your particular model of machine. For 
instructions to determine which model of machine you have, refer to Installation and Setup.

• TCP/IP and HTTP protocols must be enabled on the machine so that the machine Web browser 
can be accessed.

Procedure 

Note: The upgrade should take less than 10 minutes unless there are network issues.

1. At your workstation, open the Web browser and enter the IP Address of the machine in the 
Address Bar.

2. Press Enter.
3. Select the Login link at the top of the screen. Enter the Administrator User Name (admin) and 

Password (1111), and select Login. 
4. Select Properties.
5. In the Security link on the left hand side select the System Security link.
6. Select the Feature Management link in the directory tree. 
7. Select the Firmware Upgrade Enable check box. 
8. Click Apply to save the changes.
9. Select the Support tab.
10. In the Firmware Upgrade link select the Upgrade Wizard button. 
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Software Update
11. The Firmware Upgrade Wizard screen appears. In the Firmware File area:
a. Select Browse.
b. Locate and select the software upgrade .hd file obtained earlier.
c. Select Open.

12. Select Next. The firmware will now be verified and display information about the upgrade file. 
13. Select Next to continue. The upgrade should take less than 10 minutes unless there are network 

issues.
14. Once the machine has completed the upgrade it will reboot automatically. To check the firmware 

version, open CWIS by entering your machines IP address in your browser window. Select 
Machine Settings. Select Firmware, then Properties to see if the firmware has been updated to 
the new version. 
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7Troubleshooting

This chapter includes:
• Overview
• Clearing Paper Jams
• Common Problems
• Further Assistance
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Overview
Overview

This section provides information on what to do if a problem occurs with your machine. Follow this 
problem-solving procedure:
1. When the machine status light changes or an error occurs, follow the steps indicated in this 

section to resolve the problem.
2. If the problem cannot be resolved, power off and on, and try the job again. 
3. If the problem persists, call for service. 

Machine Status Indicators

The color of each Status LED on the control panel indicates the machine’s current status in several 
areas of operation. The table below describes how to interpret each LED and its status indicators.

Status LED Color Status Description

Machine 
Status 

None Off The machine is offline.
The machine is in power save mode.

Green
On The machine is on-line and ready to be used.

 Blinking Blinking slowly: The machine is receiving and printing 
data.
Blinking rapidly: the machine is printing data.

Red

Blinking A minor error has occurred and the machine is waiting 
for the error to be cleared. When it clears, the machine 
resumes.

On • A cover is open. Close the cover.
• There is no paper in the tray. Load paper in the tray. 

(See Paper and Media.)
• The machine has stopped due to a major error. 

Reboot the power and try the print job again. If the 
problem persists, call for service. 

• The Drum Cartridge has almost reached its 
estimated life. It is recommended to replace the 
Drum Cartridge now. (See Replacing the Drum 
Cartridge.)

Orange
Blinking Upgrading firmware.

On A paper jam has occurred (See Clearing Paper Jams.)
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Overview
Avoiding Paper Jams

If these guidelines are followed, most paper jams can be avoided. 
• Ensure that the adjustable guides on the paper tray are positioned correctly. 

• Do not overload the tray. Ensure that the paper level is below the paper capacity mark on the 
inside of the tray.

• Do not remove paper from the tray while your machine is printing.
• Flex, fan, and straighten paper before loading. 
• Do not use creased, damp, or highly curled paper.
• Do not mix paper types in a tray.
• Use only recommended print media. (See Media Types.)
• Ensure that the recommended side of the print media is facing down in the tray, or facing up in 

the Manual Feed Slot, top edge first.
• Do not print duplex output with the rear door open.

Toner Orange Blinking Small amount of toner is left in the cartridge. Prepare a 
new cartridge for replacement. You may temporarily 
increase the printing quality by redistributing the toner 
(See Redistributing Toner.)

On The toner cartridge has almost reached its estimated 
cartridge life. It is recommended to replace the toner 
cartridge (see Replacing the Toner Cartridge).

Off The toner cartridge is at normal capacity.

WPS Blue Blinking The machine is connecting to a wireless network.

On The machine is connected to a wireless network 

Off The machine is not connected to a wireless network.

Power Blue On The machine is in power save mode.

Off The machine is in ready mode or the machine’s power is 
off. 

ECO Green On Earth Smart mode is on.

Off Earth Smart mode is off. 

Status LED Color Status Description
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Overview
Avoiding Paper Curl
1. Open the rear cover.
2. Leave the rear cover open. Prints will be delivered face 

up.

Note: The rear cover output can only be used for simplex 
jobs one sheet at a time. Do not leave rear cover open 
for duplex jobs.

Note: Use when the printout has more than 20mm curl. 
Also effective to prevent wrinkling when printing 
envelopes. 
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Clearing Paper Jams
Clearing Paper Jams

When a paper jam occurs, the machine status light turns orange. Check the accessible machine areas 
for paper stuck in the paper path and remove it carefully. Follow these directions to resolve paper jam 
problems in various areas of the machine. 

Paper Tray Jams

1. Pull out the paper tray. 
2. Remove any jammed paper by gently pulling it straight 

out.

3. Pull the paper tray out completely to access inside the machine.
4. Release the two green latches positioned above 

where the paper tray sits. A baffle will drop down 
giving you access to the paper path. 
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Clearing Paper Jams
5. When the baffle drops down, remove any paper from 
that area of the paper path. 

6. Push the baffle back up in place until the two latches 
click.

7. Ensure the paper is loaded correctly. Insert the tray back 
into the machine until it snaps into place. Printing 
automatically resumes.
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Clearing Paper Jams
Manual Feed Slot Jams
1. If the paper is not feeding properly, pull the paper out of 

the machine.
2. Close the Manual Feed Slot cover. 
3. Open the machine front cover and then close it. 
4. Re-load the paper in the Manual Feed Slot to resume 

printing. 

Clearing Jams Inside the Machine

CAUTION: Some areas of the machine are hot. Take care when removing paper from the 
machine.

1. Open the front cover. Pull the toner cartridge out.

2. Remove the jammed paper by lifting the baffle and 
gently pulling the paper out straight. 
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Clearing Paper Jams
3. Reinstall the toner cartridge. Tabs on the sides of the 
cartridge and corresponding grooves within the machine 
will guide the cartridge into the correct position until it 
locks into place. 

4. Close the front cover. Printing automatically resumes.

Duplex and Exit Area Jams 
1. Open the rear cover of the machine. 

2. Press down and pull out the green latches (and 
attached baffle) on either side of opening. 
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Clearing Paper Jams
3. Remove any paper you see, working slowly so that 
you don’t tear any pieces or damage machine 
parts. 

4. After removing the paper you see, pull the baffle 
up until the latches click into place. 

5. Close the rear cover. Printing will resume 
automatically.
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Common Problems
Common Problems

The following chart lists some conditions that may occur and the recommended solutions. Follow the 
suggested solutions until the problem is corrected. If the problem persists, call for service.

Paper Feeding Problems

Condition Suggested Solutions

Paper jams during printing. • Clear the paper jam. (See Clearing Paper Jams.)

The paper keeps jamming. • There is too much paper in the tray. Remove excess paper from the tray. 
If you are printing on special media, use the Manual Feed Slot.

• An incorrect type of paper is being used. Use only paper that meets the 
specifications required by the machine. (See Media Types.)

• There may be debris inside the machine. Open the front cover and 
remove any debris (See Cleaning the Machine.).

Paper sticks together. • Check the maximum paper capacity of the tray. (See Media 
Specifications.)

• Make sure that you are using the correct type of paper. (See Media 
Types.)

• Remove paper from the tray and flex or fan the paper.
• Humid conditions may cause some paper to stick together.
• Different types of paper may be stacked in the tray. Load paper of only 

one type, size, and weight.

Paper does not feed into the 
machine.

• Remove any obstructions from inside the machine.
• Paper has not been loaded correctly. Remove paper from the tray and 

reload it correctly.
• There is too much paper in the tray. Remove excess paper from the tray.
• The paper is too thick. Use only paper that meets the specifications 

required by the machine. (See Media Specifications.)

Transparencies stick together in 
the paper exit.

• Use only transparencies specifically designed for laser printers. Remove 
each transparency as it exits from the machine.

Envelopes skew or fail to feed 
correctly.

• Ensure that the paper guides are against both sides of the envelopes.
• Feed envelopes one at a time through the Manual Feed Slot. 
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Common Problems
Printing Problems

Condition Possible Cause Suggested Solutions

The machine does not print. The machine is not receiving 
power.

• Check the power cord connections.
• Check the power switch and the 

power source.

The machine is not selected as 
the default printer.

• On your PC, select your machine as 
your default printer in Windows.

Check the machine for the following:
• The front door is not closed. Close the front door.
• Paper is jammed. Clear the paper jam. (See Avoiding Paper Jams.)
• No paper is loaded. Load paper. 
• The output tray is full. Remove the prints from the output tray and the 

machine will resume printing. 
• The toner cartridge is not installed. Install the toner cartridge.
If a system error occurs, contact your service representative.

The connection cable between 
the computer and the machine 
is not connected properly.

• Turn off the printer. Disconnect the 
machine cable and reconnect it. Turn 
the printer on.

The connection cable between 
the computer and the machine 
is defective.

• If possible, attach the cable to 
another computer that is working 
properly and print a job. You can also 
try using a different machine cable.

The port setting is incorrect. • Check the Windows printer setting to 
make sure that the print job is sent 
to the correct port. If the computer 
has more than one port, make sure 
that the machine is attached to the 
correct one.

The machine may be 
configured incorrectly. 

• Check the printer driver options to 
ensure that all of the print settings 
are correct. (See Print Procedure.)

The printer driver may be 
installed incorrectly.

• Reinstall the printer software. (See 
Installation and Setup.)

The machine is malfunctioning. • Check the machine status light on 
the control panel to see if the 
machine is indicating a major error. 
Contact a service representative.

•

A print job is extremely slow. The job may be very complex. • Reduce the complexity of the page 
or try adjusting the print quality 
settings.
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Common Problems
Half the page is blank. The page orientation setting 
may be incorrect.

• Change the page orientation in your 
application. See the printer driver 
help screen.

The paper size and the paper 
size settings do not match.

• Ensure that the paper size in the 
printer driver settings matches the 
paper in the tray.

• Or, ensure that the paper size in the 
printer driver settings matches the 
paper selection in the software 
application settings you use.

The machine prints, but the 
text is wrong, garbled, or 
incomplete.

The machine cable is loose or 
defective.

• Disconnect the machine cable and 
reconnect. Try a print job that you 
have already printed successfully. If 
possible, attach the cable and the 
machine to another computer that 
you know works and try a print job.

• Try a new machine cable.

The wrong printer driver was 
selected.

• Check the application’s printer 
selection menu to ensure that your 
machine is selected.

The software application is 
malfunctioning.

• Try printing a job from another 
application.

The operating system is 
malfunctioning.

• Exit the operating system and reboot 
the computer. Turn the machine off 
and back on again.

If you are in a DOS 
environment, the font setting 
for your machine may be set 
incorrectly.

Change the font setting. You can set the 
font from Device Settings in Xerox Easy 
Printer Manager program. 

Pages print, but they are blank. The toner cartridge is defective 
or out of toner.

• Redistribute the toner. (See 
Redistributing Toner.)

• If necessary, replace the toner 
cartridge (See Replacing the Toner 
Cartridge.).

The file may have blank pages. • Check the file to ensure that it does 
not contain blank pages.

Some parts, such as the 
controller or the board, may be 
defective.

• Contact a service representative.

Condition Possible Cause Suggested Solutions
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Common Problems
Print Quality Problems

If the inside of the machine is dirty or paper has been loaded improperly, there might be a reduction in 
print quality. See the table below to clear the problem. 

The machine does not print a 
PDF file correctly. Some parts of 
graphics, text, or illustrations 
are missing.

Incompatibility between the 
PDF file and the Acrobat 
products.

• Printing the PDF file as an image 
may enable the file to print. Turn on 
Print As Image from the Acrobat 
printing options. It will take longer to 
print when you print a PDF file as an 
image.

The print quality of photos is 
not good. Images are not clear.

The resolution of the photo is 
very low. 

• Reduce the photo size. If you 
increase the photo size in the 
software application, the resolution 
will be reduced. 

Before printing, the machine 
emits vapor near the output 
tray.

Using damp paper can cause 
vapor during printing.

• Load a new batch of paper. 
• To avoid the paper absorbing too 

much moisture, do not open 
packages of paper until required.

The machine does not print 
special- sized paper, such as 
billing paper.

Paper size and paper size 
setting do not match.

• Set the correct paper size in the 
Custom Paper tab in the Printing 
Preferences (See Paper Options.)

Condition Suggested Solutions

Light or faded print • If a vertical white streak or faded area appears on the page, the toner supply is low. 
You may be able to temporarily extend the toner cartridge life. (See Redistributing 
Toner.) If this does not improve the print quality, install a new toner cartridge.

• The paper may not meet paper specifications; for example, the paper may be too 
moist or rough. (See Media Guidelines.)

• If the entire page is light, the print resolution setting is too low or the ECO mode is 
on. Adjust the print resolution and turn the ECO mode off. See the help screen of the 
printer driver.

• A combination of faded or smeared defects may indicate that the toner cartridge or 
the area around it needs cleaning. (See Cleaning the Machine.) If these steps do not 
correct the problem, call for service. 

Toner specks • The paper may not meet specifications; for example, the paper may be too moist or 
rough. (See Media Guidelines.)

• The transfer roller may be dirty. Clean the inside of your machine. (See Cleaning the 
Machine.)

• The paper path may need cleaning. Call for service.

Condition Possible Cause Suggested Solutions
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Common Problems
Dropouts If faded areas, generally rounded, occur randomly on the page:
• A single sheet of paper may be defective. Try reprinting the job.
• The moisture content of the paper is uneven or the paper has moist spots on its 

surface. Try a different brand of paper. (See Media Guidelines.)
• The paper lot is damaged. The manufacturing processes can cause some areas to 

reject toner. Try a new ream or brand of paper.
• Change the printer option and try again. Go to Printing Preferences, select Paper 

tab, and set type to Thick. (See Paper Options.)
• If these steps do not correct the problem, contact a service representative.

White Spots If white spots appear on the page:
• The paper is too rough and dirt from the paper falls to the inner areas of the 

machine on to the transfer roller. Clean the inside of your machine. (See Cleaning 
the Machine.).

• The paper path may need cleaning. Clean your machine. (See Cleaning the 
Machine.) If these steps do not correct the problem, contact a service representative.

Vertical lines If black vertical streaks appear on the page, the surface of the drum cartridge inside the 
machine has probably been scratched. 
• Remove the drum cartridge and install a new one. (See Replacing the Drum 

Cartridge.)
If white vertical streaks appear on the page, the inside of the machine may be dirty.
• Clean the inside of your machine. (See Cleaning the Machine.) 
If these steps do not correct the problem, contact a service representative.

Dark Background If the amount of background shading becomes unacceptable:
• Change to a lighter weight paper. (See Media Specifications.)
• Check the environmental conditions: very dry conditions or a high level of humidity 

(higher than 80% RH) can increase the amount of background shading.
• Remove the old toner cartridge and install a new one. (See Replacing the Toner 

Cartridge.)

Toner smear If toner smears on the page: 
• Clean the inside of the machine. (See Cleaning the Machine.)
• Check the paper type and quality. (See Media Guidelines.)
• Remove the toner cartridge and install a new one. (See Replacing the Toner 

Cartridge.)

Condition Suggested Solutions

A a B b C
A a B b C
A a B b C
A a B b C
A a B b C
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Common Problems
Vertical repetitive 
defects

If marks repeatedly appear on the printed side of the page at even intervals:
• The toner cartridge may be damaged; run a few prints through the machine and if 

you still have the problem, remove the toner cartridge and install a new one. (See 
Replacing the Toner Cartridge.)

• Parts of the machine may have toner on them. If the defects occur on the back of 
the page, the problem will likely correct itself after a few more pages.

• The fusing assembly may be damaged. Contact a service representative.

Background scatter Background scatter results from bits of toner randomly distributed on the printed page. 
• The paper may be too damp. Load a new batch of paper. Do not open packages of 

paper until necessary so that the paper does not absorb too much moisture.
• If background scatter occurs on an envelope, change the printing layout to avoid 

printing over areas that have overlapping seams on the reverse side. Printing on 
seams can cause problems. Or select Thick Envelope from the Printing Preferences 
window.

• If background scatter covers the entire surface area of a printed page, adjust the 
print resolution through your software application or using the printer driver options. 
(See Print Procedure.)

Misformed 
characters

• If characters are improperly formed and producing hollow images, the paper stock 
may be too slick. Try different paper. (See Media Guidelines.)

Page skew • Ensure that the paper is loaded properly.
• Check the paper type and quality. (See Media Guidelines.)
• Ensure that the guides are not too tight or too loose against the paper stack. 

Curl or wave • Ensure that the paper is loaded properly.
• Check the paper type and quality. Both high temperature and humidity can cause 

paper curl. (See Media Guidelines.)
• Turn the stack of paper over in the tray. Also try rotating the paper 180 degrees in 

the tray. 
• Change the printer option and try again. Go to Printing Preferences, select Paper 

tab, and set type to Thin. (See Print Procedures.)
• If the job is simplex, use the rear door as the output location. For instructions, refer 

to Avoiding Paper Curl.

Condition Suggested Solutions

A

A a B b CA a B b CA a B b CA a B b C cA a B b C c
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Common Problems
Wrinkles or creases • Ensure that the paper is loaded properly.
• Check the paper type and quality. (See Media Guidelines.)
• Turn the stack of paper over in the tray. Also try rotating the paper 180 degrees in 

the tray.

Back of printouts 
are dirty

Check for leaking toner. Clean the inside of the machine. (See Cleaning the Machine.)

Solid Black pages • The toner cartridge may not be installed properly. Remove the cartridge and reinsert 
it.

• The toner cartridge may be defective. Remove the toner cartridge and install a new 
one. (See Replacing the Toner Cartridge.)

• The machine may require repair. Contact a service representative.

Loose toner • Clean the inside of the machine. (See Cleaning the Machine.)
• Check the paper type and quality. (See Media Guidelines.)
• Remove the toner cartridge and install a new one. (See Replacing the Toner 

Cartridge.)
• The machine may require repair. Contact a service representative.

Character Voids Character voids are white areas within parts of characters that should be solid black:
• If you are using transparencies, try another type of transparency. Because of the 

composition of transparencies, some character voids are normal. 
• You may be printing on the wrong surface of the paper. Remove the paper and turn 

it around. 
• The paper may not meet paper specifications. (See Media Specifications.)

Condition Suggested Solutions

A

A
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Common Problems
Common PostScript Problems

The following situations are PS language specific and may occur when several printer languages are 
used.

Horizontal stripes If horizontally aligned black lines, stripes, streaks or smears appear:
• The toner cartridge may not be installed properly. Remove the cartridge and reinsert 

it.
• The toner cartridge may be defective. Remove the toner cartridge and install a new 

one. (See Replacing the Toner Cartridge.)
• If the problem persists, the machine may require repair. Contact a service 

representative.

An unknown image 
repetitively 
appears on a few 
sheets, or loose 
toner, light print, or 
contamination 
occurs.

• Your machine is probably being used at an altitude of 1,500 m (4,921 ft) or above. 
The high altitude may affect the print quality, such as loose toner or light imaging. 
Change to the correct altitude setting for your machine. (See System Setup.)

Problem Possible Cause Solution

PostScript file cannot be printed. The PostScript driver may not be 
installed correctly.

• Install the PostScript driver. 
(See Install Printer Software.)

• Print a configuration page and 
verify that the PS version is 
available for printing.

• If the problem persists, contact 
a service representative.

Limit Check Error report prints. The print job was too complex. • You might need to reduce the 
complexity of the page. 

A PostScript error page prints. The print job may not be 
PostScript.

• Make sure that the print job is 
a PostScript job. Check to see 
whether the software 
application expected a setup 
or PostScript header file to be 
sent to the machine.

Condition Suggested Solutions

A a B b C
A a B b C
A a B b C
A a B b C
A a B b C
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Common Problems
Common Windows Problems

Note: Refer to the Microsoft Windows User Guide supplied with your computer for further 
information on Windows error messages.

Common Macintosh Problems

Note: Refer to the Macintosh User Guide supplied with your computer for further information on 
Macintosh error messages.

Condition Suggested Solutions

File in Use message appears during installation. • Exit all software applications. Remove all software 
from the printer’s startup group, then restart 
Windows. Re-install the printer driver.

General Protection Fault, Exception OE, Spool 32, or 
Illegal Operation messages appear.

• Close all other applications, reboot Windows and 
try printing again.

Fail To Print, A printer timeout error occurred 
messages appear on your PC.

• These messages may appear during printing. Just 
keep waiting until the machine finishes printing. 
If the message appears in standby mode or after 
printing has been completed, check the 
connection and/or whether an error has occurred.

Machine information is not displayed when you click 
the device in the Devices and Printers.

Check the Printer properties. Select the Ports tab.
(Control Panel > Devices and Printers > Right-click on 
your printer icon and select Printer properties)
If the port is set to File or LPT, clear the check boxes 
and select TCP/IP, USB, or WSD.

Condition Suggested Solutions

The machine does not print 
PDF files correctly. Some parts 
of graphics, text, or illustrations 
are missing.

• Printing the PDF file as an image may enable the file to print. Turn on 
Print As Image from the Acrobat printing options. 

Note: It will take longer to print when you print a PDF file as an image.

The document has printed, but 
the print job has not 
disappeared from the spooler in 
Mac OS X10.3.2. 

• Update your MAC OS to OS X 10.5 or higher.
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Common Problems
Common Linux Problems 

Refer to your Linux User Guide for further information on Linux error messages.

Condition Suggested Solutions

The machine does not print. • Check if the printer driver is installed on your system. Open the Unified 
Driver Configurator and switch to the Printers tab in the Printers 
configuration window to look at the list of available machines. Make 
sure that your machine is displayed on the list. If not, open the Add new 
printer wizard to set up your machine.

• Check if the machine is started. Open the Printers configuration 
window and select your machine from the printer list. Look at the 
description in the Selected printer pane. If its status contains Stopped, 
press the Start button. Normal operation of the machine should be 
restored. The stopped status might be activated if problems in printing 
occurred. For instance, this could be an attempt to print a document 
when the port is being used by a scanning application.

• Ensure the port is not busy. Since functional components of the 
machine (printer and scanner) share the same I/O interface (port), 
simultaneous access of different consumer applications to the same 
port is possible. To avoid possible conflicts, only one of them at a time is 
allowed to gain control over the machine. The other consumer will 
encounter a device busy response. You should open the Ports 
Configuration window and select the port assigned to your machine. In 
the Selected port pane you can see if the port is occupied by some 
other application. If this is the case, you should either wait for 
completion of the current job or press the Release port button.

• Check if your application has a special print option such as -oraw. If -
oraw is specified in the command line parameter, then remove it to 
print properly. For Gimp front-end, select the print -> Setup printer and 
edit command line parameters in the command item.
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Further Assistance
Further Assistance

For any additional help visit our customer Web site at www.xerox.com or contact the Xerox Support 
Center quoting the machine serial number.

Locating the Serial Number

The serial number can be found:
• On the machine’s data plate on the rear cover.
• On the Configuration report. See instructions below to print the report.
• On the CentreWare Internet Services Home page. See below to access CWIS status and reports.

Printing Machine Reports

You can print various reports on your Xerox machine's status, configuration, and supplies from the 
control panel and from CentreWare Internet Services. 

From the Machine:

To print a Demo/Sample page: 
• Press and hold the red Cancel button on the printer control panel until the machine status button 

starts blinking--about 1-2 seconds, then release.

To print a Configuration report which provides information about your machine setup, including the 
serial number, IP Address, installed settings and the software version:
• Press and hold the red Cancel button on the printer control panel for about 4 seconds until the 

status LED blinks fast, and release.

To print a Supplies and Usage status:
• Press and hold the red Cancel button on the printer control panel for about 10 seconds and 

release.

From CentreWare:

From a networked PC, you can find your machine’s serial number, print a configuration report, and 
browse the status. To get to CentreWare Internet Services:
• Open a Web browser at your networked computer.
• Enter the machine's IP address in the browser address window. 
• CentreWare Internet Services opens to the Home page, where you can see the Serial Number on 

the left. Select the Status tab to see Supplies and other machine status information.
• To print reports, click Information > Print Information. Select and print the report you need.
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8Specifications

This chapter includes:
• Machine Specifications
• Print Specifications
• Network Environment
• System Requirements
• Electrical Specifications
• Environmental Specifications
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Machine Specifications
Machine Specifications

Machine Configurations 

Component Phaser 3052NI Phaser 3260DI, DNI

Hardware Configuration 600 mHz Processor
256 MB Memory
Paper Tray and Manual Feed Slot

600 mHz Processor
256 MB Memory
Duplex Unit
Paper Tray and Manual Feed Slot

Connectivity Configuration Network, Wireless and USB DI: Wireless and USB
DNI: Network, Wireless and USB

Machine Size
(width x depth x height)

14.4 x 13.17 x 8.4 inches
368 x 334.5 x 213 mm

Machine Weight 
Net (with consumables)

15.87 lbs (7.2 kg) 16.31 lbs (7.4 kg)

Access From the front and back

First Print Out Time Less than 8.5 seconds from Ready

Warm Up Time Less than 14 seconds from Power Save
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Print Specifications
Print Specifications

Feature Phaser 3052NI Phaser 3260DI/DNI

Speed: Simplex Up to 27 ppm on Letter
Up to 26 ppm on A4 

Up to 29 ppm on Letter
Up to 28 ppm on A4 

Speed: Duplex Manual Duplex Automatic Duplex
Up to 13 ppm on Letter
Up to 12 ppm on A4

Maximum Print Area 8.5 x 14 inches US Legal 
(216 mm x 356 mm)

Maximum Print Resolution 600 x 600 dpi
Up to 1200 x 1200 dpi effective output

Average Print Cartridge Yield From Toner Cartridge supplied with the machine: 1500 standard 
prints

From Standard Toner Cartridge: 3000 standard prints

Standard Printer Memory 256 MB

Compatibility Windows PC / MAC / Linux/ Unix

Printer Languages PCL5e, PCL6, SPL PCL5e, PCL6, SPL
Postscript 3
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Print Specifications
Media Specifications

Paper Trays

Manual Feed Slot 

Duplex Unit

Output Tray

Feature Phaser 3052NI / Phaser 3260DI, DNI

Capacity: Main Tray 250 sheets 20 lb (80 g/m²) bond paper

Media Weights 16 - 43 lb (60 to 163 g/m²)

Media Sizes Length: min: 5.85 inches (148 mm); max: 14 inches (356 mm)
Width: min: 4.13 inches (105 mm); max: 8.5 inches (216 mm)
A4, A5, A6, Letter, Legal, Folio, Oficio, Executive, ISO B5, JIS B5

Media Types Plain Paper, Thin, Thick, Recycled, Bond, Archive

Feature Phaser 3052NI/ Phaser 3260DI/DNI

Capacity 1 sheet 20 lb (80 g/m²) bond paper, envelope

Media Weights 16 - 58 lb (60 to 220 g/m²)

Media Sizes Length min 5 - max 14 inches (127 - 356 mm)
Width min 3 - max 8.5 inches (76.2 - 216 mm)

A4, A5, A6, Letter, Legal, Folio, Oficio, Executive, ISO B5, JIS B5, 
3 in x 5 in, Envelope (Monarch, No.10, DL, C5, C6)

Media Types Plain, Thin, Thick, Cotton, Colored, Envelope, Transparency, Pre-
Printed, Recycled, Labels, Bond, Card stock, Archive

Feature Phaser 3052NI Phaser 3260DI/DNI

Media Weights n/a 16 - 28 lb (60 to 120 g/m²)

Media Sizes n/a A4, Letter, Oficio, Folio, Legal

Media Types n/a Plain Paper, Thin, Thick, Recycled

Feature Phaser 3052NI/ Phaser 3260DI/DNI

Output Tray - Face down 150 sheets of 20 lb (80 g/m²) bond paper

Rear Door - Face up 1 sheet
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Network Environment
Network Environment

Item Phaser 3052NI Phaser 3260DI/DNI

Network interface • Ethernet 10/100/1000 Base-TX
• 802.11b/g/n Wireless LAN
• High Speed USB 2.0

DI: 802.11b/g/n Wireless LAN and High 
Speed USB 2.0
DNI: Ethernet 10/100/1000 Base-TX, 
802.11b/g/n Wireless LAN, and High 
Speed USB 2.0

Network operating 
system

• Windows 7, 8 / XP / Server 2003 / Server 2008/ Vista / Server 2008 R2
• Various Linux OS
• Mac OS X 10.5 ~ 10.9
• Unix

Network protocols • TCP/IP, TCP/IPv6
• DHCP, BOOTP
• Bonjour, SLP, UPnP, Telnet
• Standard TCP/IP Printing, LPR, IPP, SNMP v 1/2/3, HTTP, IPSec
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System Requirements
System Requirements

Microsoft® Windows®

Macintosh

Operating 
System CPU RAM Free HDD 

Space

Windows 
Server® 2003 
(32/64 bit)

Intel® Pentium® III 933 MHz (Pentium IV 1 GHz) 128 MB (512 
MB)

1.25 GB to 2 GB

Windows 
Server® 2008
(32/64 bit)

Intel® Pentium® IV 1 GHz (Pentium IV 2 GHz) 512 MB (2 GB) 10 GB

Windows Vista®

(32/64 bit)

Intel® Pentium® IV 3 GHz 512 MB (1 GB) 15 GB

Windows® 7 & 
Windows® 8
(32/64 bit)

Intel® Pentium® IV 1 GHz 32-bit or 64-bit 
processor or higher

1 GB (2 GB) 16 GB

• Support for DirectX® 9 graphics with 128 MB memory (to enable the Aero theme)
• DVD-R/W Drive

Windows 
Server® 2008 R2
(32/64 bit)

Intel® Pentium® IV 1 GHz (x86) or 1.4 GHz (x64) 
processors (2 GHz or faster)

512 MB (2 GB) 10 GB

Windows® XP 
(32/64 bit)

Intel® Pentium® III 933 MHz (Pentium IV 1 GHz) 128 MB (256 
MB)

1.5 GB

Notes: • Internet Explorer 6.0 or higher is the minimum requirement for all Windows operating 
systems.

• Users who have administrator rights can install the software.
• Windows Terminal Services is compatible with your machine.

Operating System CPU RAM
Free 
HDD 

Space

Mac OS X 10.5 Intel® processors
867 MHz or faster PowerPC G4 / G5

512 MB (1 GB) 1 GB

Mac OS X 10.6 Intel® processors 1 GB (2 GB) 1 GB

Mac OS X 10.7 - 10.9 Intel® processors 2 GB 4 GB
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System Requirements
Linux

Unix

Operating System CPU RAM Free HDD 
Space

• Fedora 11-19 

• OpenSuSE® 11.0, 11.1, 11.2, 11.3, 11.4, 12.1, 12.2, 
12.3

• Ubuntu 10.04, 10.10, 11.04, 11.10, 12.04, 12.10, 
13.04

• Debian 5.0, 6.0, 7.0, 7.1

• Redhat® Enterprise Linux 5, 6
• SuSE Linux Enterprise Desktop 10, 11
• Mint 13, 14, 15

Pentium IV 2.4GHz 
(Intel Core™2)

512 MB 
(1 GB)

1 GB 
(2 GB)

Operating System Free HDD 
Space

Sun Solaris 9, 10, 11 (x86, SPARC)
HP-UX 11.0, 11i v1, 11i v2, 11i v3 (PA-RISC, Itanium)
IBM AIX 5.1, 5.2, 5,3, 5.4, 6.1, 7.1 (PowerPC)

Up to 100 MB
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Electrical Specifications
Electrical Specifications

Feature Phaser 3052NI/ Phaser 3260DI/DNI

Frequency 50/60 Hz

Electrical Voltage Low voltage: 110 - 127 VAC
High voltage: 220 - 240 VAC

Average Power Consumption Operating Average: Maximum 400 Watts
Power Save mode: Less than 1.2 Watts
Power Off mode: Less than 0.7 Watts
Stand By mode: Less than 45 Watts
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Environmental Specifications
Environmental Specifications

Feature Phaser 3052NI/ Phaser 3260DI/DNI

Operating Temperature - 
both printer and consumables

Between 10 - 32 degrees C (50 - 90 degrees F)

Relative Humidity Acceptable Humidity range: 10 - 80% 
Optimal humidity range: 20 - 70%
Optimal relative humidity at 28 degrees C (82 F)
Note: Under extreme environmental conditions, such as 10 C and 
80% relative humidity, defects can occur due to condensation.

Elevation For optimum performance, use the printer at elevations below 
3100 M (10,170 ft.). 
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Environmental Specifications
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9Safety

This chapter includes:
• Electrical Safety
• Operational Safety
• Maintenance Safety
• Environmental, Health, and Safety Contact Information

Your printer and the recommended supplies have been designed and tested to meet strict safety 
requirements. Attention to the following information ensures the continued safe operation of your 
Xerox printer.
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Electrical Safety
Electrical Safety

General Guidelines

WARNING: Unauthorized alterations, which may include the addition of new functions or 
connection of external machines, may impact the machine certification. Contact your Xerox 
representative for more information.

• Do not push objects into slots or openings on the printer. Touching a voltage point or shorting 
out a part could result in fire or electric shock.

• Do not remove the covers or guards that are fastened with screws unless you are installing 
optional equipment and are instructed to do so. Turn off the printer when performing these 
installations. Disconnect the power cord when removing covers and guards for installing 
optional equipment. Except for user-installable options, there are no parts that you can 
maintain or service behind these covers.

The following are hazards to your safety:
• The power cord is damaged or frayed.
• Liquid is spilled into the printer.
• The printer is exposed to water.
• The printer emits smoke, or the surface is unusually hot.
• The printer emits unusual noise or odors.
• The printer causes a circuit breaker, fuse, or other safety device to activate.

If any of these conditions occur, do the following:
1. Turn off the printer immediately.
2. Disconnect the power cord from the electrical outlet.
3. Call an authorized service representative.

Power Cord

Use the power cord supplied with your printer.
• Plug the power cord directly into a properly grounded electrical outlet. Ensure that each end of the 

cord is connected securely. If you do not know if an outlet is grounded, ask an electrician to check 
the outlet.

WARNING: To avoid risk of fire or electrical shock, do not use extension cords, power strips, or 
power plugs for more than 90 days. When a permanent outlet receptacle cannot be installed, use 
only one factory-assembled extension cord of the appropriate gauge per printer or multifunction 
printer. Always adhere to national and local building, fire, and electrical codes regarding length of 
cord, conductor size, grounding, and protection.

• Do not use a ground adapter plug to connect the printer to an electrical outlet that does not have 
a ground connection terminal.
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Electrical Safety
• Verify that the printer is plugged into an outlet that is providing the correct voltage and power. 
Review the electrical specification of the printer with an electrician if necessary.

• Do not place the printer in an area where people can step on the power cord.
• Do not place objects on the power cord.
• Do not plug or unplug the power cord while the power switch is in the On position.
• If the power cord becomes frayed or worn, replace it.
• To avoid electrical shock and damage to the cord, grasp the plug when unplugging the power cord.

The power cord is attached to the printer as a plug-in device on the back of the printer. If it is necessary 
to disconnect all electrical power from the printer, disconnect the power cord from the electrical outlet. 

Emergency Turn Off

If any of the following conditions occur, turn off the printer immediately and disconnect the power 
cord from the electrical outlet. Contact an authorized Xerox service representative to correct the 
problem if:
• The equipment emits unusual odors or makes unusual noises.
• The power cable is damaged or frayed.
• A wall panel circuit breaker, fuse, or other safety device has been tripped.
• Liquid is spilled into the printer.
• The printer is exposed to water.
• Any part of the printer is damaged.

Laser Safety

This printer complies with laser product performance standards set by governmental, national, and 
international agencies and is certified as a Class 1 Laser Product. The printer does not emit hazardous 
light because the beam is totally enclosed during all modes of customer operation and maintenance.

WARNING: Use of controls, adjustments, or performance of procedures other than those 
specified in this manual can result in hazardous radiation exposure.
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Operational Safety
Operational Safety

Your printer and supplies were designed and tested to meet strict safety requirements. These include 
safety agency examination, approval, and compliance with established environmental standards.

Your attention to the following safety guidelines helps to ensure the continued, safe operation of your 
printer.

Operational Guidelines
• Do not remove any paper trays while the printer is printing.
• Do not open the doors when the printer is printing.
• Do not move the printer when it is printing.
• Keep hands, hair, neckties, and so on, away from the exit and feed rollers.
• Covers, which require tools for removal, protect the hazard areas within the printer. Do not remove 

the protective covers.

Ozone Release

This printer produces ozone during normal operation. The amount of ozone produced is dependent on 
copy volume. Ozone is heavier than air and is not produced in amounts large enough to harm anyone. 
Install the printer in a well-ventilated room.

For more information in the United States and Canada, go to www.xerox.com/environment. In other 
markets, contact your local Xerox representative or go to www.xerox.com/environment_europe.

If you need additional information about ozone, request the Xerox publication Facts About Ozone 
(part number 610P64653) by calling 1-800-828-6571 in the United States and Canada. In other 
markets, contact your local Xerox representative. 

Printer Location
• Place the printer on a level, solid, non-vibrating surface with adequate strength to hold its weight. 

To find the weight for your printer configuration, see Machine Specifications.
• Do not block or cover the slots or openings on the printer. These openings are provided for 

ventilation and to prevent overheating of the printer.
• Place the printer in an area where there is adequate space for operation and servicing.
• Place the printer in a dust-free area.
• Do not store or operate the printer in an extremely hot, cold, or humid environment.
• Do not place the printer near a heat source.
• Do not place the printer in direct sunlight to avoid exposure to light-sensitive components.
• Do not place the printer where it is directly exposed to the cold air flow from an air conditioning 

system.
• Do not place the printer in locations susceptible to vibrations.
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Operational Safety
• For optimum performance, use the printer at the elevations specified in Environmental 
Specifications.

Printer Supplies
• Use the supplies designed for your printer. The use of unsuitable materials can cause poor 

performance and a possible safety hazard.
• Follow all warnings and instructions marked on, or supplied with, the product, options, and 

supplies.
• Store all consumables in accordance with the instructions given on the package or container.
• Keep all consumables away from the reach of children.
• Never throw toner, print/drum cartridges, or toner containers into an open flame.
• When handling cartridges, for example toner and such, avoid skin or eye contact. Eye contact can 

cause irritation and inflammation. Do not attempt to disassemble the cartridge, which can 
increase the risk of skin or eye contact.

CAUTION: Use of non-Xerox supplies is not recommended. The Xerox Warranty, Service 
Agreement, and Total Satisfaction Guarantee do not cover damage, malfunction, or degradation 
of performance caused by use of non-Xerox supplies, or the use of Xerox supplies not specified for 
this printer. The Total Satisfaction Guarantee is available in the United States and Canada. 
Coverage could vary outside these areas. Contact your Xerox representative for details.
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Maintenance Safety
Maintenance Safety

• Use supplies and cleaning materials only as directed in the Maintenance section of this manual.
• Do not remove covers or guards that are fastened with screws. There are no parts behind these 

covers that you can maintain or service.
• Do not attempt any maintenance procedure that is not specifically described in the 

documentation supplied with your printer.
• Clean with a dry lint-free cloth only.

WARNING: Aerosol cleaners can be explosive or flammable when used on electromechanical 
equipment. 

• Do not burn any consumables or routine maintenance items. For information on Xerox supplies 
recycling programs, go to www.xerox.com/gwa.

Printer Symbols

Symbol Description

Warning:
Indicates a hazard which, if not avoided, could result in death or serious injury.

Caution:
Indicates a mandatory action to take in order to avoid damage to the property.

Hot surface on or in the printer. Use caution to avoid personal injury.

Do not burn the item.

Do not expose the imaging unit to light for more than 10 minutes.

Do not expose the imaging unit to direct sunlight.
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Maintenance Safety
Do not touch the part or area of the printer.

Warning:
Wait for the printer to cool for the specified time before touching the fuser.

This item can be recycled. For details, see Recycling and Disposal.

Symbol Description
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Environmental, Health, and Safety Contact Information
Environmental, Health, and Safety Contact 
Information

For more information on Environment, Health, and Safety in relation to this Xerox product and supplies, 
contact the following customer help lines:

United States: 1-800 ASK-XEROX

Canada: 1-800 ASK-XEROX

Europe: +44 1707 353 434

For product safety information in the United States, go to www.xerox.com/environment.

For product safety information in Europe, go to www.xerox.com/environment_europe. 
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10Regulatory

This chapter includes:
• Basic Regulations
• Material Safety Data
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Basic Regulations
Basic Regulations

Xerox has tested this device to electromagnetic emission and immunity standards. These standards are 
designed to mitigate interference caused or received by this device in a typical office environment.

United States (FCC Regulations)

This device has been tested and found to comply with the limits for a Class A digital device, pursuant to 
Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful 
interference in a commercial environment. This device generates, uses, and can radiate radio frequency 
energy. If it is not installed and used in accordance with these instructions, it may cause harmful 
interference to radio communications. Operation of this device in a residential area is likely to cause 
harmful interference in which case the user will be required to correct the interference at his/her own 
expense.

If this device does cause harmful interference to radio or television reception, which can be determined 
by turning the device off and on, the user is encouraged to try to correct the interference by one or 
more of the following measures:
• Reorient or relocate the receiver.
• Increase the separation between the equipment and receiver.
• Connect the equipment into an outlet on a circuit different from that to which the receiver is 

connected.
• Consult the dealer or an experienced radio/television technician for help.

Changes or modifications to this equipment not approved by Xerox can void the authority of the user 
to operate this equipment.

Note: To ensure compliance with Part 15 of the FCC rules, use shielded interface cables.

Canada

This Class A digital apparatus complies with Canadian ICES-003.

Cet appareil numérique de la classe A est conforme à la norme NMB-003 du Canada.
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Basic Regulations
European Union
CAUTION: This is a Class A product. In a domestic environment, this product can cause 
radio interference in which case the user could be required to take adequate measures.

The CE mark applied to this device symbolizes Xerox’s declaration of conformity with the 
following applicable Directives of the European Union as of the dates indicated:

• December 12, 2006: Low Voltage Directive 2006/95/EC
• December 15, 2004: Electromagnetic Compatibility Directive 2004/108/EC
• March 9, 1999: Radio & Telecommunications Terminal Equipment Directive 1999/5/EC

This printer, if used properly in accordance with the user's instructions, is not dangerous for the 
consumer or for the environment.

To ensure compliance with European Union regulations, use shielded interface cables.

A signed copy of the Declaration of Conformity for this device can be obtained from Xerox.

European Union Lot 4 Imaging Equipment Agreement Environmental 
Information

Environmental Information Providing Environmental Solutions and Reducing Cost

Introduction

The following information has been developed to assist users and has been issued in relation to the 
European Union (EU) Energy Related Products Directive, specifically the Lot 4 study on Imaging 
Equipment. This requires manufacturers to improve environmental performance of in scope products 
and supports the EU action plan on energy efficiency.

In scope products are Household and Office equipment that meet the following criteria.
• Standard monochrome format products with a maximum speed less than 66 A4 images per 

minute
• Standard color format products with a maximum speed less than 51 A4 images per minute

Environmental Benefits of Duplex Printing

Most Xerox products have duplex printing, also known as 2-sided printing, capability. This enables you 
to print on both sides of the paper automatically, and therefore helps to reduce the use of valuable 
resources by reducing your paper consumption. The Lot 4 Imaging Equipment agreement requires that 
on models greater than or equal to 40 ppm color or greater than or equal to 45 ppm monochrome the 
duplex function has been auto enabled, during the setup and driver installation. Some Xerox models 
below these speed bands may also be enabled with 2-sided printing settings defaulted on at the time 
of install. Continuing to use the duplex function will reduce the environmental impact of your work. 
However, should you require simplex/1-sided printing, you may change the print settings in the printer 
driver.
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Basic Regulations
Paper Types

This product can be used to print on both recycled and virgin paper, approved to an environmental 
stewardship scheme, which complies with EN12281 or a similar quality standard. Lighter weight paper 
(60 g/m2), which contains less raw material and thus save resources per print, may be used in certain 
applications. We encourage you to check if this is suitable for your printing needs.

ENERGY STAR

The ENERGY STAR program is a voluntary scheme to promote the development and purchase of 
energy efficient models, which help to reduce environmental impact. Details on the ENERGY STAR 
program and models qualified to ENERGY STAR can be found at the following Web site: 
www.energystar.gov/index.cfm?fuseaction=find_a_product.showProductGroup&pgw_code=IEQ

The Xerox Phaser 3260 Printer is ENERGY STAR® qualified under the ENERGY STAR Program 
Requirements for Imaging Equipment.

The ENERGY STAR and ENERGY STAR MARK are registered United States trademarks. The ENERGY 
STAR Imaging Equipment Program is a team effort between U.S., European Union and Japanese 
governments and the office equipment industry to promote energy-efficient copiers, printers, fax, 
multifunction machines, personal computers, and monitors. Reducing product energy consumption 
helps combat smog, acid rain, and long-term changes to the climate by decreasing the emissions that 
result from generating electricity.

Xerox ENERGY STAR equipment is preset at the factory. Your printer will be delivered with the timer for 
switching to Power Save Mode from the last copy/print out, set at one minute. A more detailed 
description of this feature can be found in the Getting Started section of this guide.

Power Consumption and Activation Time

The amount of electricity a product consumes depends on the way the device is used. This product is 
designed and configured to enable you to reduce your electricity costs. After the last print, the device 
switches to Ready mode. In this mode, the device can print again immediately if required. If the 
product is not used for a period of time, the device switches to a Power Saver mode. In these modes, 
only essential functions remain active in order to enable reduced product power consumption.

Upon exiting from Power Saver Mode, the first print will take slightly longer than in Ready Mode. This 
delay is the result of the system waking up from Power Saver mode and is typical of most imaging 
products on the market.
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Basic Regulations
If you wish to set a longer Activation Time or would like to completely deactivate the Power Save 
Mode, consider that this device may then only switch to a lower energy level after a longer period of 
time or not at all. 

To learn more about Xerox participation in sustainability initiatives, visit our Web site at: 
www.xerox.com/about-xerox/environment/enus.html.

For additional information on energy or other related topics, visit: 
www.xerox.com/about-xerox/environment/enus.html or 
www.xerox.co.uk/about-xerox/environment/engb.html.

Germany

Blue Angel

The Xerox® Phaser ®3260 DI/DNI is Blue Angel certified under the RAL-UZ-171 requirements for 
Imaging Equipment.

RAL, the German Institute for Quality Assurance and Labeling, has awarded this device the Blue Angel 
Environmental Label. This label distinguishes it as a device that satisfies Blue Angel criteria for 
environmental acceptability in terms of device design, manufacture, and operation. 

For more information, go to: www.blauer-engel.de.

Blendschutz

Das Gerät ist nicht für die Benutzung im unmittelbaren Gesichtsfeld am Bildschirmarbeitsplatz 
vorgesehen. Um störende Reflexionen am Bildschirmarbeitsplatz zu vermeiden, darf dieses Produkt 
nicht im unmittelbaren Gesichtsfeld platziert werden.

Larmemission
Maschinenlärminformatians-Verordnung3 . GPSGV: Der höchste Schalldruckpegel beträgt 70 dB(A) 
oder weniger gemäß EN ISO 7779.

Importeur
Xerox GmbH
Hellersbergstraße 2-4
41460 Neuss
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Basic Regulations
Deutschland

Turkey RoHS Regulation

In compliance with Article 7 (d). We hereby certify:

"It is compliant with the EEE Regulation."

EEE yönetmeliğine uygundur.

Regulatory information for 2.4 Ghz Wireless LAN Module

This product contains a 2.4 Ghz Wireless LAN radio transmitter module which complies with the 
requirements specified in FCC Part 15, Industry Canada RSS-210 and European Council Directive 
99/5/EC.

Operation of this device is subject to the following two conditions: (1) this device may not cause 
harmful interference, and (2) this device must accept any interference received, including interference 
that may cause undesired operation.

Changes or modifications to this device not specifically approved by the Xerox Corporation may void 
the user's authority to operate this equipment.
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Material Safety Data
Material Safety Data

For Material Safety Data information regarding your printer, go to:

North America: www.xerox.com/msds

European Union: www.xerox.com/environment_europe

For the Customer Support Center phone numbers, go to www.xerox.com/office/worldcontacts
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Material Safety Data
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11Recycling and Disposal

This chapter includes recycling and disposal information for:
• All Countries
• North America
• European Union
• Other Countries
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All Countries
All Countries

If you are managing the disposal of your Xerox product, please note that the printer may contain lead, 
mercury, perchlorate, and other materials whose disposal may be regulated due to environmental 
considerations. The presence of these materials is fully consistent with global regulations applicable at 
the time that the product was placed on the market. For recycling and disposal information, contact 
your local authorities. 

Perchlorate Material 

This product may contain one or more Perchlorate-containing devices, such as batteries. Special 
handling may apply. Please see www.dtsc.ca.gov/hazardouswaste/perchlorate. 
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North America
North America

Xerox operates an equipment take-back and reuse/recycle program. Contact your Xerox representative 
(call 1-800-ASK-XEROX) to determine if this Xerox product is part of the program. 

For more information about Xerox environmental programs, visit www.xerox.com/environment, or for 
local recycling and disposal information, contact your local authorities.
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European Union
European Union

Some equipment may be used in both a domestic/household and a professional/business application.

Domestic/Household Environment

Application of this symbol on your equipment is confirmation that you should not dispose 
of the equipment in the normal household waste stream.

In accordance with European legislation, end of life electrical and electronic equipment 
subject to disposal must be segregated from household waste. Private households within 

EU member states may return used electrical and electronic equipment to designated collection 
facilities free of charge. Please contact your local disposal authority for information. In some member 
states, when you purchase new equipment, your local retailer may be required to take back your old 
equipment free of charge. Please ask your retailer for information. 

Professional/Business Environment

Application of this symbol on your equipment is confirmation that you must dispose of this 
equipment in compliance with agreed national procedures.

In accordance with European legislation, end of life electrical and electronic equipment 
subject to disposal must be managed within agreed procedures. Prior to disposal, please contact your 
local reseller or Xerox representative for end of life take-back information.

Collection and Disposal of Equipment and Batteries

These symbols on the products and/or accompanying documents mean that used electrical and 
electronic products and batteries should not be mixed with general household waste. For proper 
treatment, recovery, and recycling of old products and used batteries, please take them to applicable 
collection points, in accordance with your national legislation and the Directive 2002/96/EC and 
2006/66/EC. 

By disposing of these products and batteries correctly, you will help to save valuable resources and 
prevent any potential negative effects on human health and the environment which could otherwise 
arise from inappropriate waste handling.

For more information about collection and recycling of old products and batteries, please contact your 
local municipality, your waste disposal service, or the point of sale where you purchased the items. 

Penalties may be applicable for incorrect disposal of this waste, in accordance with national legislation.
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European Union
Business Users in the European Union

If you wish to discard electrical and electronic equipment, please contact your dealer or supplier for 
further information. 

Disposal Outside of the European Union

These symbols are only valid in the European Union. If you wish to discard these items, please contact 
your local authorities or dealer and ask for the correct method of disposal. 

Battery Symbol Note

This wheeled bin symbol may be used in combination with a chemical symbol. This 
establishes compliance with the requirements set out by the Directive. 

Battery Removal

Batteries should only be replaced by a MANUFACTURER-approved service facility.
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Other Countries
Other Countries

Please contact your local waste management authority to request disposal guidance.
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